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Chapitre 1 : Introduction

1-1 Introduction
Nous vous remercions de la confiance que vous nous témoignez en choisissant l’interface
graphique MX-View, destinée aux enregistreurs TASCAM des séries MX et MM.
Ce mode d’emploi se propose de guider les ingénieurs du son, qu’ils soient novices ou
expérimentés, tout au long du processus d’enregistrement audio à l’aide de l’interface graphique
MX-View. Il se peut que les vétérans chevronnés de l’enregistrement audio sur ordinateur
décident de se passer de la lecture de ce mode d’emploi. Si vous faites partie de ceux-ci, nous vous
encourageons à lire au moins le Chapitre 3 Présentation, qui décrit brièvement toutes les fenêtres
et les boutons de l’interface MX-View, ainsi que les principes élémentaires relatifs à
l’enregistrement, l’édition, le réglage des événements et les pistes virtuelles. L’interface MX-View
va vous étonner par ses nombreuses nouvelles fonctions, ses raccourcis clavier et des modes de
travail entièrement novateurs. Pour ceux d’entre vous qui découvrent le monde de l’édition audio
sur ordinateur, nous vous souhaitons la bienvenue ! Avant d'aller plus loin, prenez le temps de
parcourir le manuel afin de vous familiariser avec les différents boutons et fenêtres. Prenez votre
souris en main et nous allons vous faire découvrir toutes les possibilités de l’interface MX-View :
enregistrement, lecture, édition, sauvegarde… Préparez-vous à vivre une nouvelle expérience dans
le domaine de l’ingénierie audio.
Avant toute chose, veuillez noter que ce mode d’emploi couvre tous les aspects de l’interface
MX-View ; il vient en complément des modes d’emploi des enregistreurs MX-2424 et
MMR/MMP. Il ne comprend pas les explications relatives à la synchronisation, à la configuration
des entrées/sorties numériques ou aux réglages de façade. Pour obtenir ces informations, veuillez
consulter les modes d’emploi des MX-2424 ou MMR/MMP.

1-2 Conventions typographiques
La rédaction de ce manuel est basée sur les conventions suivantes :

→ La flèche indique la localisation d’un menu. Par exemple, View Menu→ Waveforms
vous renvoie au menu déroulant View, puis à l’option Waveforms.

Cmd Cmd signale qu’il faut appuyer sur la touche Commande (Pomme) d’un clavier de
Macintosh.

Ctrl Ctrl signale qu’il faut appuyer sur la touche Control (Ctrl) d’un clavier Microsoft
Windows ou Macintosh.

+ Le symbole plus permet de décrire un raccourci clavier. Exemple : Cmd + B indique qu’il
faut maintenir la touche Commande enfoncée et appuyer sur la touche B.

5
&

Ce symbole désigne un Raccourci Clavier ; il décrit une autre manière d’exécuter une
fonction à l’aide d’un raccourci clavier.

� Le symbole de la page signale une note importante qu’il est essentiel de garder en
mémoire.

$
VWXFH

Le symbole de l’Astuce désigne une astuce essentielle et pertinente qui peut vous aider à
exploiter tout le potentiel de votre enregistreur.

______________________________________________________________________________________
� Note : Il se peut que certaines captures d’écran du manuel du MX-View ne reflètent pas les

affichages graphiques de la version la plus récente du logiciel. Cela est en partie dû à l’utilisation
de la plate-forme BeOS pour les captures d’écran, ainsi qu’à des modifications récentes qui n’ont
pas été inclues dans cette version du mode d’emploi.
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Chapitre 2 : Configuration Ethernet

Le Chapitre 2 passe en revue les deux configurations Ethernet matérielles de base, ainsi que les
configurations système requises. Veuillez consulter les notes de mise à jour du MX-View pour obtenir les
instructions d’installation du logiciel.

2-1 Configuration requise
Veuillez consulter les notes de mise à jour pour obtenir la configuration requise.

2-2 Connexion directe d’un MX-2424/MMR à un ordinateur
Vous pouvez directement connecter un ordinateur utilisant MX-View à un enregistreur
MX-2424/MMR à l’aide d’un câble Ethernet croisé de catégorie 5. Connectez une
extrémité du câble au port Ethernet de l’enregistreur et l’autre extrémité au port Ethernet
de l’ordinateur.

2-3 Connexion d’un MX-2424/MMR à ordinateur via un concentrateur (Hub)
 Ethernet

Vous pouvez relier un seul MX-2424/MMR ou un groupe d’enregistreurs
MX-2424/MMR à un ordinateur équipé de MX-View grâce à un Hub Ethernet rapide
100-baseT. Tous les câbles de cette configuration doivent être des câbles Ethernet
standard de catégorie 5 (câbles non croisés).

Reliez chaque enregistreur au Hub, ainsi que l’ordinateur. Le port de liaison (Uplink) du
Hub doit uniquement être utilisé pour relier ce Hub spécifique à un autre Hub.

� Note : Généralement, la longueur des câbles Ethernet ne doit pas excéder 100 mètres.

Câble Ethernet croisé

Ordinateur
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� Note : Il est possible de réaliser des configurations en réseau plus complexes, avec plusieurs
stations de travail MX-View, routeurs, Hubs et enregistreurs. Veuillez consulter votre
administrateur réseau pour la configuration d’un réseau complexe.

2-4 Définition des adresses IP
Réglages IP du MX-2424
Pour accéder au menu 950 du MX-2424, appuyez sur SETUP, sur la touche numérique
“0”, puis plusieurs fois sur la flèche inférieure. Une adresse IP s’affiche, similaire à celle-
ci : 192.168.100.001. NOTE : Il se peut que les nombres soient différents, mais ils
suivent néanmoins la règle XXX.XXX.XXX.YYY.

Si votre ordinateur est déjà relié à un réseau avec modem Câble/DSL, la portion
XXX.XXX.XXX de l’adresse IP doit être identique à la portion correspondante de
l’adresse IP déjà assignée à votre ordinateur. La portion YYY de l’adresse IP du
MX-2424 doit être unique et différente de la portion YYY de l’ordinateur. Assurez-vous
que ce nombre est situé entre 1 et 254.

Sous Windows :
Sur le bureau de votre ordinateur, effectuez un clic droit sur l’icône de Voisinage réseau
et sélectionnez l’option Propriétés. Placez en surbrillance l’icône TCP/IP correspondant à
la carte Ethernet installée sur votre ordinateur et cliquez sur Propriétés.

Câble Ethernet non croisé

Câble Ethernet non croisé

Câble Ethernet non croisé

Câble Ethernet non croisé

Ordinateur

Hub Ethernet
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Sélectionnez l’option Spécifier une adresse IP et inscrivez la portion XXX.XXX.XXX du
menu 950 du MX-2424 dans le champ Adresse IP, telle qu’elle est affichée sur le
MX-2424. Inscrivez une valeur différente pour la portion YYY de l’adresse IP. Assurez-
vous que ce nombre est compris entre 1 et 254.

Exemple : Si le menu 950 affiche 192.168.100.001, le champ Adresse IP de l’ordinateur
doit indiquer 192.168.100.YYY, où YYY est une valeur comprise entre 002 et 254. Sur
l’ordinateur, saisissez la valeur 255.255.255.000 comme Masque de sous-réseau.
Appuyez deux fois sur OK et redémarrez l’ordinateur.

Sur Macintosh :
Ouvrez le Tableau de bord TCI/IP, auquel vous pouvez accéder via le menu Pomme, dans
le menu Tableaux de bord. Réglez l’option Connexion sur “Ethernet” et l’option
Configuration sur “Manuellement”.

Saisissez la portion XXX.XXX.XXX du menu 950 du MX-2424 dans le champ Adresse
IP, telle qu’elle est affichée sur le MX-2424. Saisissez une valeur différente pour la
portion YYY de l’adresse IP. Assurez-vous que ce nombre est situé entre 1 et 254.

Exemple : Si le menu 950 affiche 192.168.100.001, alors le champ Adresse IP de
l’ordinateur doit afficher 192.168.100.YYY, où la valeur YYY est comprise entre 002 et
254.

Sur l’ordinateur, saisissez la valeur 255.255.255.000 comme Masque sous-réseau.
Fermez le Tableau de bord TCP/IP pour sauvegarder les modifications, puis redémarrez
l’ordinateur.
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Chapitre 3 : Présentation

Le Chapitre 3 comporte deux sections : Fenêtres de l’interface graphique MX-View et Guide de prise en
main. Le Guide de prise en main fournit des astuces et indications pour une prise en main rapide de
l’interface, avec des exemples d’opérations courantes. La section des Fenêtres de l’interface graphique
MX-View illustre les principales fenêtres de MX-View et apporte des brèves descriptions des fonctions
disponibles, ce qui vous permet de vous familiariser avec la présentation de l’interface.

Fenêtres de l’interface graphique MX-View

3-1 Fenêtre principale de MX-View

Input All :  Place
toutes les pistes
actives en mode
d’entrée.

Record Arm All : Toutes
les pistes actives s’arment
pour l’enregistrement.

Edit All : Place toutes
les pistes en mode Edit.
Pratique pour éditer
toutes les pistes.

Début de
sélection (In)

Fin de sélection
(Out)

Marqueur de position
Règle temporelle

Piste

Portion audio
sélectionnée

Numéro de
 piste

Piste active

Piste inactive/
virtuelle

Armement en enregistrement :
Rouge clignotant – Enregistrement
armé.
Rouge continu – En enregistrement.

Entrée :
Jaune continu – Entrée armée.
Mi-allumée – Enregistrement
armé.

Tête de
lecture

Afficher/Masquer
les pistes virtuelles

Nom de piste

Groupe

Nom d’événement

Poignée de
piste virtuelle

Menu des pistes

Edition des
pistes

Dans la fenêtre principale de
MX-View, vous pouvez afficher ou
masquer les colonnes, selon le travail
que vous souhaitez effectuer. Pour
afficher ou masquer des colonnes,
accédez à la fenêtre Columns via le
Menu View → Columns et
sélectionnez les colonnes à afficher.
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3-2 Fenêtre de transport

$
VWXFH

En sélectionnant l’option Show Transport Hints (Afficher astuces de transport), dans le
menu d’aide de la fenêtre Edit), vous pouvez accéder à tous les raccourcis clavier
invisibles dans les menus.

3-3 Fenêtre Project/Track

Compteur de lecture : Affiche la
position de la tête de lecture. Permet
de localiser la tête de lecture (section
4-8).

Capture des points
de départ et final
d’une sélection

Outil de sélection : Permet de
sélectionner et éditer des régions
audio.

Outil de déplacement/réglage des événéments
(Drag and Trim) : Permet de sélectionner et éditer
des événements individuels, de déplacer et de
régler la durée des événements, ainsi que
l’automation du Volume et du Mute.

Outil Scrub et
Outil Stylo.
Disponibles dans
une mise à jour à
venir.

Compteur Nudge

Outil Zoom : Zooms avant ou
arrière sur une région audio.

Temps de Pre-Roll

Temps de Post-Roll

Options Pre-Roll et Post-Roll.
Cliquez sur une case pour activer
l’option correspondante.

Point de départ de la sélection

Point final de la
sélection

Durée de la sélection

Retour
rapide

Lecture
inversée

Stop

Lecture

Avance rapide
Enregistrement

Répétition

En ligne
Localisation tête
de lecture

Localisation Précédent

Localisation Suivant

Localisation
point final

Auto (Enregistr./
Répétition
automatiques)

Boucle

Disque : Identifiant de
disque SCSI suivi de
l’espace disque disponible,
entre parenthèses.

Nom de projet : Double-
cliquez dessus pour ouvrir
un projet.

Nom de piste

Afficher/
Masquer
Pistes

Afficher/
Masquer
Projets

Icône : Notez que cette icône indique le type de
système de fichiers (Logo Apple dans cet
exemple).
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3-4 Fenêtre Overview
La fenêtre Overview présente la totalité d’un projet, offrant une visualisation ainsi qu’une
navigation rapides vers tout point du projet. Lorsque vous sélectionnez une région dans la
fenêtre Overview, cette région s’affiche dans la fenêtre principale de MX-View. Lorsque
vous effectuez un seul clic dans la fenêtre Overview, l’affichage de la fenêtre principale
de MX-View se place sur la position sur laquelle vous avez cliqué. Si l’option Menu
Playback → Locate with View est sélectionnée et que le MX-2424 n’est pas en cours de
transport, la tête de lecture se place au centre de la nouvelle vue.

3-5 Fenêtre Meters (Afficheurs de niveau)
La fenêtre Meters affiche 24 afficheurs indiquant l’amplitude du niveau audio (affichage
similaire à celui que vous trouvez en façade du MX-2424).

3-6 Réglages des menus ( N/C)
Cette fonction sera disponible dans une mise à jour ultérieure.

3-7 Fenêtre Location Markers ( N/C)
Cette fonction sera disponible dans une mise à jour ultérieure.

3-8 Fenêtre Groups ( N/C)
Cette fonction sera disponible dans une mise à jour ultérieure.

Evénements (gris foncé)

Affichage de la fenêtre principale (sélection en bleu)

Présence de signal
(-50 dB)

Ecrêtage du signal (0 dB)

Mémoire
de crête

Niveau du
signal
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3-9 Barre Edit
La barre d’édition comprend les fonctions de base, divisées en six sections (de gauche à
droite) : Vue des pistes, fonctions d’édition élémentaires, sélection du presse-papier,
sélection du mode d’édition, fonctions d’édition avancées et section d’ouverture des
fenêtres.

3-10 Barre Machine Info
La barre Machine Info comprend des données importantes, notamment le nom du projet,
la fréquence d’échantillonnage, le type de Time Code, le mode de contrôle, le statut des
bus, la référence des échantillons, le codage du disque, le mode d’enregistrement et le
disque d’enregistrement (identifiant et type). La LED d’activité Busy reflète la LED Busy
située en façade de l’appareil. Cette LED d’activité s’avère pratique lorsque l’enregistreur
se trouve dans un local d’équipements séparé ou hors de portée visuelle directe. Le menu
déroulant permet de sélectionner les valeurs Bus Offset (décalage bus), Timecode Offset
(décalage Time Code), Timecode Reader (lecteur Time Code) et Free space (espace
disponible), avec le compteur situé à droite.

Zoom avant/arrière
(Horizontal)

Augmenter/diminuer la
hauteur d’affichage des
pistes

Couper      Coller     Insérer

Copier   Supprimer  Ouvrir

Multiple sélection
du presse-papier

Edition
d’événements

Edition de
l’automation
des Mutes

Edition de
l’automation
du volume

Annuler

Rétablir

Fade

Zoom arrière vertical

Zoom avant vertical

Nudge gauche

Marqueur

Nudge droit

Fenêtre de Transport

Fenêtre Machine Settings

Fenêtre Overview

Fenêtre Meters
Fenêtre Location Markers

Fenêtre Project/Track

Fenêtre Groups

Fenêtre Network

Vous pouvez personnaliser la barre Machine
Info de sorte qu’elle affiche ou masque certains
segments d’information. Sélectionnez Menu
View→ Machine Info Segments, puis
sélectionnez les segments que vous souhaitez
afficher.
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3-11 Fenêtre Network
La fenêtre Network affiche les enregistreurs auxquels vous pouvez être connecté. Cette
fenêtre est particulièrement pratique si vous disposez de plusieurs enregistreurs sur un
bus synchronisé. Vous pouvez sélectionner plusieurs appareils en maintenant enfoncée la
touche Commande sur Macintosh ou la touche Ctrl sous Windows, puis en cliquant sur
les appareils souhaités. Une fois les appareils sélectionnés, vous pouvez ouvrir la fenêtre
principale de MX-View avec tous appareils sélectionnés en appuyant sur la barre
d’espace ou en sélectionnant Menu File → Edit .

Guide de prise en main

3-12 Créer un nouveau projet
Pour commencer un nouveau projet, connectez d’abord le multipiste souhaité depuis la
fenêtre Network. Double-cliquez sur le nom de l’enregistreur pour ouvrir la fenêtre
principale de MX-View. Dans le menu File, sélectionnez New Project pour ouvrir cette
fenêtre :

Inscrivez le nom du projet (champ Name), puis l’identifiant du disque d’enregistrement,
la taille des échantillons, la fréquence d’échantillonnage et le type de Time Code. Si vous

Informations concernant l’appareil

Nom de l’appareil :
Double-cliquez dessus
pour ouvrir la fenêtre
principale de MX-View.

Vous pouvez personnaliser la fenêtre Network en
affichant ou en masquant certaines colonnes. Sélectionnez
la fenêtre Menu Machine → Columns dans la fenêtre
Network, puis sélectionnez les colonnes que vous
souhaitez afficher.
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souhaitez placer votre session en mode Tape, cliquez une fois sur la case Tape mode.
Cliquez sur OK pour continuer. Vous êtes maintenant prêt à enregistrer !

3-13 Lecture et enregistrement élémentaires
Enregistrement :
Utilisez les boutons d’armement en enregistrement pour sélectionner les pistes de
destination de l’enregistrement.

Pour commencer à enregistrer, cliquez sur le bouton REC de la fenêtre de transport de
sorte qu’il clignote, puis cliquez sur le bouton Play. Le bouton REC et les boutons
d’armement en enregistrement s’allument en continu – l’enregistrement est lancé.

Pour arrêter l’enregistrement, appuyez sur la barre d’espace ou sur le bouton Stop de la
fenêtre de transport. Désarmez les pistes préparées pour l'enregistrement.

Lecture de votre enregistrement :
Pour placer la tête de lecture sur le point de départ du projet, cliquez sur le bouton Head
de la fenêtre de transport.

Vous pouvez alors cliquer sur le bouton Play ou appuyer sur la barre d’espace pour lancer
la lecture des données audio enregistrées.
Vous pouvez placer la tête de lecture sur tout point de la fenêtre principale de MX-View
en un seul clic de souris lorsque l’outil de sélection est activé ().
Pour obtenir plus de détails sur les opérations de lecture, d’enregistrement et de
navigation, consultez le Chapitre 5.

3-14 Réaliser une édition par copier-coller
Sélection d’une région :
Pour sélectionner une région à éditer, vous devez d’abord sélectionner l’icône Edition
d’événements (dans la barre Edit). Notez que l’icône Edition d’événements doit être
sélectionnée pour toute édition d’événements audio.

 

Pour sélectionner une région, utilisez l’outil de sélection de la fenêtre de transport ().
Effectuez un cliquer-déplacer sur la région audio souhaitée, de sorte qu’elle soit
sélectionnée en bleu.

Armement en enregistrement

Play et REC s’allument en continu durant l’enregistrement

Localisation du point de départ

Edition d’événements
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Copier des données :
Pour copier la région sélectionnée dans le presse-papier, cliquez sur le bouton Copier de
la barre d’édition.

Coller des données :
Pour coller les données copiées, vous devez d’abord choisir une destination de copie.
Avec l’outil de sélection, effectuez un cliquer-déplacer vers la position souhaitée.

Cliquez sur Coller pour placer le contenu du presse-papier sur la position souhaitée.

Région en
surbrillance
sélectionnée pour
l’édition

Copier    Coller

Position de
destination de
l’opération Coller

Evénement audio
collé depuis le
presse-papier
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Vous pouvez annuler ou rétablir une édition en cliquant sur le bouton Annuler (Undo) ou
Rétablir (Redo) de la barre d’édition.

Les opérations d’édition élémentaires sont expliquées dans le Chapitre 6 et les opérations
d’édition avancées sont détaillées dans le Chapitre 7.

3-15 Réglage des événements audio
Pour modifier un événement audio, sélectionnez d’abord cet événement à l’aide de l’outil

de déplacement/réglage des événements (Drage and Trim) () situé dans la fenêtre de
transport.  Les poignées de réglage des événements s’affichent, permettant de modifier le
volume, la durée ou les Fades de l’événement. Dans l’exemple ci-dessous, la poignée
horizontale gauche de l’événement permet d’étendre la durée de l’événement.

Pour modifier la durée de l’événement, placez le curseur de la souris sur la poignée
horizontale gauche de sorte qu’il s’affiche sous forme d’une double flèche (↔). Cliquez-
déplacez la poignée vers la gauche pour allonger la durée de l’événement.

Pour de plus amples détails sur le réglage des événements, consultez les sections 7-1 à 7-
8 du Chapitre 7.

Annuler       Rétablir

Evénement
sélectionné

Poignées de
volume

Poignées
horizontales

Poignées de
Fade
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3-16 Principes de base des pistes virtuelles
Trois types de pistes sont utilisés par l’interface MX-View : les pistes chargées, les pistes
virtuelles et les pistes non chargées. Cette section traite des pistes chargées (actives) et
des pistes virtuelles.

Les pistes chargées sont des pistes “actives” que vous pouvez lire, enregistrer et
éditer. Elles sont visibles dans la fenêtre principale de MX-View.

Les pistes virtuelles sont des pistes “inactives”. Elles sont visibles et peuvent
être éditées. Cependant, vous ne pouvez pas les placer en lecture ni y enregistrer
des données.

Création d’une nouvelle piste virtuelle :
Pour créer une nouvelle piste virtuelle, sélectionnez une piste dont vous souhaitez
enregistrer une prise alternative. Ouvrez le menu déroulant des pistes, comme illustré ci-
dessous, et sélectionnez New Virtual Track. Inscrivez le nom de la nouvelle piste
virtuelle et cliquez sur OK. La nouvelle piste virtuelle apparaît en dessous.

Chargement d’une piste virtuelle
Pour activer les fonctions de lecture et d’enregistrement d’une piste virtuelle, vous devez
charger (ou “activer”) la piste souhaitée. Cliquez sur le bouton d’activation de la piste
virtuelle (de sorte qu’il s’allume) pour charger ou activer la piste.

Pour plus de détails sur la gestion des pistes virtuelles, consultez la section 4-6 et le
Chapitre 10.

La piste virtuelle 1 est inactive.
Les données audio de cette piste
peuvent être visualisées et éditées,
mais elles ne peuvent pas être lues
ni enregistrées.

La piste virtuelle 3 est inactive.
Les données audio de cette piste
peuvent être visualisées et éditées,
mais elles ne peuvent pas être lues
ni enregistrées.

Cliquez sur le bouton d’activation
de la piste virtuelle 2 afin de

l’activer. Les données audio de
cette piste peuvent être lues et

enregistrées.

Bouton du menu
des pistes

Menu
déroulant des
pistes
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Chapitre 4 : Terminologie et principes de l’interface MX-View

Ce chapitre propose une présentation générale des projets, pistes, événements et formes d’ondes, ainsi que
d’utilisation des fenêtres. Les deux dernières sections de ce chapitre décrivent le réglage des points In et
Out, ainsi que l’utilisation des compteurs.

4-1 Utilisation des fenêtres
Les fenêtres de l’interface MX-View permettent de personnaliser votre mode de travail.
Vous pouvez masquer, afficher, déplacer, réduire ou agrandir les fenêtres de MX-View.
Pour ouvrir ces fenêtres, vous pouvez utiliser les boutons destinés à cet effet dans la
section droite de la barre d’édition, le menu déroulant Windows ou les raccourcis clavier
correspondants.

� Note : Les fenêtres de l’interface graphique MX-View n’ont pas toutes les mêmes propriétés. Les
fenêtres présentant des caractéristiques différentes seront signalées.

Macintosh :
Lorsque vous travaillez sur une plate-forme Macintosh, vous pouvez aisément déplacer
une fenêtre MX-View à l’écran par cliquer-déplacer sur les bords de la fenêtre. Vous
pouvez modifier la taille d’une fenêtre MX-View en cliquant-déplaçant le coin inférieur
droit de la fenêtre. Voici les caractéristiques d’une fenêtre sous Macintosh OS 9 :

5
&

Fermeture d’une fenêtre sur Macintosh : Cmd +W

Microsoft Windows :
Sur une plate-forme Microsoft Windows, vous pouvez aisément déplacer une fenêtre
MX-View à l’écran par cliquer-déplacer sur la barre supérieure de la fenêtre. Vous
pouvez modifier la taille de la fenêtre MX-View en cliquant-déplaçant les bords ou la
barre inférieure de la fenêtre ou en utilisant le coin inférieur droit de la fenêtre.
Voici les caractéristiques d’une fenêtre sous Microsoft Windows 98 :

Fermer la
fenêtre

Modifier la taille
de la fenêtre
(cliquer-déplacer)

Masquer/dérouler
la fenêtre

Zoom/restauration de la taille de la fenêtre

Faire défiler le contenu
de la fenêtre vers le haut
ou vers le bas

Faire défiler le contenu de la fenêtre
vers la gauche ou la droite

Faire défiler le contenu de la fenêtre
vers la gauche ou la droite

Modifier la taille
de la fenêtre
(cliquer-déplacer)

Maximiser/Restaurer
la fenêtre

Fermer la fenêtre

Faire défiler le contenu
de la fenêtre vers le haut
ou vers le bas

Minimiser la
fenêtre
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5
&

Fermer une fenêtre sous Microsoft Windows : Ctrl +W

Vous pouvez ouvrir les fenêtres à l’aide du menu déroulant Windows de la fenêtre
principale de l’interface MX-View. Vous pouvez également utiliser les raccourcis clavier
suivants pour ouvrir ou fermer les fenêtres de MX-View :

5
&

Raccourcis clavier des fenêtres de MX-View

Fenêtre Microsoft Windows Macintosh
Transport Ctrl + 1 Cmd + 1

Machine Settings Ctrl + 2 Cmd + 2
Overview Ctrl + 3 Cmd + 3

Meters Ctrl + 4 Cmd + 4
Markers Ctrl + 5 Cmd + 5
Groups Ctrl + 6 Cmd + 6

Project/Track Ctrl + 7 Cmd + 7
Import/Export Audio Ctrl + 8 Cmd + 8

Edit Ctrl + 9 Cmd + 9
Network Ctrl + 0 Cmd + 0

$
VWXFH

Sous Microsoft Windows uniquement : Les raccourcis Ctrl+Tab ou Ctrl+F6 permettent
de passer d’une fenêtre ouverte (non flottante) à l’autre à l’écran. Par exemple, si les
fenêtres Network, Project/Track, Meters et Edit sont toutes ouvertes, le raccourci clavier
Ctrl+Tab permet de passer de l’une à l’autre.

4-2 Fenêtres arrimées
Les fenêtres de Transport et Overview, ainsi que les barres Machine Info et Edit peuvent
être arrimées. Elles peuvent êtres attachées à la fenêtre principale de MX-View, flotter
dessus ou être masquées.

Par défaut, lorsque vous lancez MX-View, les fenêtres de Transport et Overview sont
visibles : elles flottent sur la fenêtre principale de MX-View. Les barres Machine Info et
Edit sont toutes deux arrimées au-dessus de la règle temporelle de la fenêtre principale.

Afficher et masquer une fenêtre ou barre arrimée
Lorsque les fenêtres de Transport et Overview sont flottantes, elles peuvent être
masquées simplement par fermeture de la fenêtre (voir section 4-1 sur la fermeture d’une
fenêtre sur Macintosh ou sur PC (Microsoft Windows)). Vous pouvez restaurer
l’affichage de la fenêtre en cliquant sur le bouton correspondant dans la barre d’édition
ou en sélectionnant la fenêtre souhaitée dans le menu Windows (Menu Windows →

Barre
Machine
arrimée

Fenêtre
principale de
MX-View

Barre
d’édition
arrimée
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Menu Transport  et Windows → Overview). Vous pouvez afficher ou masquer les
barres Edit et Machine Info en sélectionnant le Menu View → Edit  ou Menu View →
Machine Info. Lorsque les barres Edit et Machine Info sont flottantes, vous pouvez les
masquer en fermant la fenêtre, comme décrit dans la section 4-1.

Du statut flottant à arrimé
Chaque fenêtre ou barre arrimée dispose d’une position d’arrimage spécifique dans la
fenêtre principale de MX-View. Pour arrimer une fenêtre ou barre flottante, cliquez dans
un espace "vide" de la fenêtre ou barre à arrimer, ou dans sa poignée si cela est possible,
puis faites-la glisser vers sa position d’arrimage. La fenêtre ou barre se magnétise alors
sur sa position d’arrimage.

Du statut arrimé à flottant
Pour faire passer une fenêtre ou barre du statut arrimé au statut flottant, cliquez dans un
espace "vide" de la fenêtre ou barre à arrimer, ou dans sa poignée si cela est possible,
puis éloignez-la de sa position d’arrimage. Déplacez la fenêtre Transport ou Overview
vers le bas de l’écran et la barre Machine Info ou Edit vers le haut de l’écran. La fenêtre
ou barre se détache de la fenêtre principale de MX-View et flotte au-dessus. La fenêtre ou
barre flottante peut alors être placée à tout endroit de l’écran.

$
VWXFH

Sous Microsoft Windows uniquement : Vous pouvez instantanément ré-arrimer une
fenêtre flottante en double-cliquant simplement dans sa barre de titre. Vous pouvez forcer
une fenêtre flottante à rester flottante en maintenant la touche Ctrl enfoncée tout en
relâchant la souris.

Les barres
Edit et
Machine Info
sont
masquées.

Barre d’édition
en statut
flottant

Barre Machine
Info en statut
flottant

Fenêtre
principale
MX-View
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4-3 Fenêtres extensibles
La fenêtre de transport, la barre Machine Info et la barre Edit peuvent être étendues ou
réduites pour afficher plus ou moins d’informations. Pour réduire ou étendre la taille
d’une fenêtre, elle doit être en statut flottant (non arrimé). Pour réduire ou étendre la taille
d’une fenêtre ou barre, cliquez sur les flèches de réduction ou d’extension illustrées ci-
dessous.

4-4 Positions des fenêtres ( N/C)
Cette fonction sera disponible dans une mise à jour ultérieure.

$
VWXFH

Chaque fois que vous fermez l’application MX-View, les positions des fenêtres sont
mémorisées par MX-View. Lorsque vous relancez l’application MX-View, les fenêtres
sont replacées selon leurs positions avant fermeture.

4-5 Utilisation des projets
Création d’un nouveau projet : Vous pouvez créer un nouveau projet en sélectionnant le
Menu File →New Project. La fenêtre New Project s’affiche, vous proposant de choisir
le nom du nouveau projet (limité à 28 caractères), l’identifiant du disque
d’enregistrement, la taille des échantillons, la fréquence d’échantillonnage, le type de
Time Code et le mode Tape ou l’édition non-destructive.

Réduction

Extension

Utilisez les menus déroulants
pour sélectionner les réglages
souhaités.
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5
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Nouveau projet : Ctrl+N sous Microsoft Windows, Cmd+N sur Macintosh

Ouvrir un projet :
Pour ouvrir un projet existant, sélectionnez Menu File → Project/Track. Vous ouvrez
ainsi la fenêtre Project/Track.

Notez que la fenêtre Project/Track peut contenir plusieurs appareils et plusieurs disques.
Cliquez sur l’appareil souhaité et sur le disque souhaité afin d’afficher tous les projets de
ce disque. Pour ouvrir un projet existant, double-cliquez sur l’icône de ce projet. Vous
trouverez dans l’Annexe D la liste des icônes de la fenêtre Project/Track.

5
&

Ouvrir un projet : Ctrl + O sous Microsoft Windows, Cmd + O sur Macintosh

Fermer un projet :
Lorsque vous ouvrez un nouveau projet ou autre projet, le projet en cours se ferme
automatiquement. Si vous souhaitez fermer un projet et placer l’enregistreur hors tension,
vous devez d’abord désactiver tous les disques. La fonction Unmount se trouve dans le
menu Volumes de la fenêtre Project/Track, ainsi qu’en façade de l’enregistreur. Lorsque
les disques sont désactivés, vous pouvez désactiver l’enregistreur.

� Note : Les projets sont automatiquement sauvegardés sur le disque lorsque vous avez appuyé sur
Stop et que les LED Busy et Disk sont inactives.

4-6 Utilisation des pistes
L’application MX-View comprend trois types de pistes : les pistes chargées, les pistes
virtuelles et les pistes non chargées.

Piste chargée (active)
Une piste chargée dans MX-View se comporte de manière similaire à une piste de
multipiste. Vous pouvez simultanément lire toutes les pistes chargées et enregistrer
différents instruments sur différentes pistes. Les pistes chargées s’affichent dans la
fenêtre principale de MX-View. Elles sont dites “actives” car elles peuvent être lues et
enregistrées. Vous pouvez éditer et organiser de nombreux événements audio sur chaque
piste.

Disque

Piste

Projet

Désactiver tous les
disques
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Le nombre de pistes chargées sur MX-View est limité par le multipiste lui-même. Ainsi,
le MX-2424 ne peut jamais lire/enregistrer plus de 24 pistes et le MMR-8 ne peut jamais
lire/enregistrer plus de 8 pistes.

Piste virtuelle (Inactive)
Les pistes virtuelles s’affichent dans la fenêtre principale de MX-View, mais elles ne
peuvent pas être lues ni enregistrées. Elles s’avèrent pratiques pour “compiler” plusieurs
prises sur une seule piste ou pour écouter différentes prises. Le MX-2424 propose jusqu’à
100 pistes virtuelles.

Les pistes virtuelles “inactives” peuvent être activées. Pour cela, cliquez sur le bouton
d’activation/désactivation de la piste. Cela désactive la piste précédemment chargée.

Piste non chargée
Les pistes non chargées ne sont pas affichées dans la fenêtre principale de MX-View.
Elles sont disponibles sous forme de liste dans la fenêtre Project/Track. Les pistes non
chargées doivent être chargées dans la fenêtre principale de MX-View pour les mettre en
lecture. Un enregistreur MX-2424 peut offrir jusqu’à 999 pistes non chargées par projet.

Pour plus de détails sur la gestion des pistes, veuillez consulter le Chapitre 10.

4-7 Evénements, régions et formes d’ondes
Un événement est un clip de données audio que vous pouvez éditer et déplacer dans les
pistes chargées et les pistes virtuelles.

Vous pouvez visualiser les événements audio sous forme de formes d’ondes, soit une
représentation graphique des données audio. Vous pouvez afficher ou masquer les formes
d’ondes en sélectionnant ou non l’option Waveforms dans Menu View → Waveforms.
Les formes d’ondes sont générées durant le processus d’enregistrement.

Une région audio peut être un événement, une partie d’événement ou un groupe
d’événements sélectionné pour l’édition.

Forme d’onde (gris
foncé)

Evénement

Piste virtuelle inactive

Piste active (chargée)

V1 est inactive et ne peut
être enregistrée ni mise en
lecture. Elle peut
toutefois être éditée.

V2 est active. Elle peut être
lue ou enregistrée.



28

4-8 Utilisation des compteurs
Les compteurs de l’application MX-View peuvent être utilisés pour visualiser et modifier
les valeurs de position, des points In et Out, des réglages Nudge, des Pre- et Post-Rolls,
pour n’en citer que quelques-unes. Voici les deux procédures de saisie d’une valeur dans
un compteur :

Sélection de tout le compteur :
1. Cliquez et faites glisser le curseur dans le compteur afin de le placer en surbrillance.

2. Saisissez les chiffres souhaités. Ils s’affichent de droite à gauche, comme en façade
du MX-2424. Dans l’exemple ci-dessous, la séquence 12345612 a été saisie en
commençant par le 1.

3. Appuyez sur la touche Enter pour vous placer sur la position choisie et quitter le
compteur.

4. Pour quitter le compteur sans modifier la position, appuyez sur la touche Esc.

Sélection d’une paire de chiffres :
1. Effectuez un clic sur une paire de chiffres pour la sélectionner.

2. Appuyez sur les flèches supérieure/inférieure pour augmenter/diminuer la valeur ou
saisissez deux chiffres. Dans l’exemple ci-dessous, nous avons appuyé quatre fois
sur la flèche supérieure :

 
3. Appuyez sur les flèches gauche/droite pour passer sur la paire suivante (soit alterner

entre heures, minutes, secondes et images). Dans l’exemple ci-dessous, nous avons
appuyé deux fois sur la flèche droite.

4. Appuyez sur la touche Enter pour vous placer sur la position choisie et quitter le
compteur.

5. Pour quitter le compteur sans modifier la position, appuyez sur la touche Esc.

4-9 Réglage des points In et Out
Le réglage des points In et Out est essentiel à la plupart des opérations sur MX-View. Il
existe plusieurs manières de définir les points In et Out.

Point In Point Out
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Capture des points In et Out dans la fenêtre de transport :
En cliquant sur le bouton Capture In, le point In se place sur la position en cours de la tête
de lecture. De même, lorsque vous cliquez sur le bouton Capture Out, le point Out se
place sur la position en cours de la tête de lecture.

Utilisation des compteurs des points In et Out :
Cliquez dans un compteur et saisissez la position In ou Out souhaitée, comme décrit dans
la section 4-8.

Sélection d’une région ou d’un événement :
Utilisez l’outil de sélection pour cliquer-déplacer le curseur sur la région souhaitée.
Sinon, vous pouvez utiliser l’outil Drag and Trim pour cliquer une fois sur un événement
ou un groupe d’événement. Les points de départ et de fin des événements deviennent les
points In et Out, respectivement. Pour plus de détails sur les outils de sélection et Drag
and Trim, veuillez vous reporter à la section 6-1.

Utilisation des raccourcis clavier :

5
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Microsoft Windows : Ctrl + × pour Capture In, Ctrl + Ø  pour Capture Out.
Macintosh : Cmd + × pour Capture In, Cmd + Ø  pour Capture Out.

Les points In et Out peuvent également être déplacés dans la règle temporelle. Pour cela,
cliquez sur le point In ou Out souhaité, et faites-le glisser jusqu’à la position souhaitée en
le déplaçant vers la gauche ou vers la droite.

Capture du point
Out

Compteur du point
Out

Compteur du point
In

         Capture du point In

Déplacement
du point In
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Chapitre 5 : Lecture, navigation et enregistrement

Le Chapitre 5 décrit les opérations, modes et options d’enregistrement et de lecture. De plus, une section de
navigation complète traite des opérations de localisation, zoom et manipulation au sein d’un projet.

Modes et options de lecture

5-1 Lecture

Pour lancer la lecture, vous pouvez appuyer sur la touche Play () de la fenêtre de
transport ou appuyer sur la barre d’espace. Durant la lecture, la tête de lecture reste
stationnaire au centre de l’écran, tandis que les pistes audio défilent horizontalement vers
la gauche, à moins qu’une autre option de lecture soit sélectionnée.

5
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Lecture ou arrêt : Barre d’espace sous Microsoft Windows ainsi que sur Macintosh.

5-2 Pages avec défilement de la tête de lecture

Lorsque l’option Pages With Playhead est sélectionnée (Menu Playback →Pages With
Playhead), la tête de lecture défile vers la droite de l’écran durant la lecture. Lorsqu’elle
atteint le bord droit de l’écran, le contenu de la fenêtre principale de MX-View avance et
la tête de lecture revient à gauche de l’écran pour recommencer à défiler.

5-3 Lecture de In à Out
La commande “In to Out” permet de lancer la lecture du point In au point Out. Lorsque la
tête de lecture atteint le point Out, elle vient se replacer sur le point In et s’arrête. Cela
s’avère très pratique pour écouter une région audio. Pour réaliser une lecture “In to Out”,
réglez les points In et Out à votre convenance (voir section 4-9) et sélectionnez Menu
Playback → In to Out .

5
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Lecture de In à Out : Shift + Barre d’espace sous Microsoft Windows et Macintosh

$
VWXFH

Pour ajouter un temps de Pre-Roll et de Post-Roll à la commande “In to Out”, cliquez sur
les options Pre-roll et Post-roll de la fenêtre de transport. La lecture “In to Out”
commence alors sur le Pre-Roll avant le point In et finit sur le Post-Roll après le point
Out. Pour plus de détails sur les Pre- et Post-Rolls, consultez la section 5-8.

Exemple : Les points In et Out sont définis et la lecture “In to Out” est lancée.

① La tête de lecture se place sur le
point In et la lecture commence.
② Lorsqu’elle atteint le point Out,
la tête de lecture se replace sur le
point In et la lecture s’arrête.

Point OutPoint In

②①

Options de Pre-Roll et
de Post-Roll
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5-4 Lecture en boucle
Pour utiliser la lecture en boucle, vous devez d’abord définir les points In et Out, comme
indiqué dans la section 4-9. Cliquez sur le bouton Loop de la fenêtre de transport pour
lancer la lecture en boucle.

� Note : Vous disposez de trois modes de lecture en boucle : lecture répétée (par défaut) ; lecture
unique et repérage ; lecture unique et arrêt. Le menu 210 du MX-2424 permet d’accéder aux modes
de lecture en boucle. Pour plus d’informations sur les modes de lecture en boucle, consultez le
menu Bank 200 du mode d’emploi du MX-2424 : Réglages système (Page 38 du mode d’emploi du
MX-2424).

Appuyez sur n’importe quel bouton de transport pour arrêter la lecture en boucle.
5

&
Ctrl + L sous Microsoft Windows, Cmd + L  sur Macintosh

5-5 Lancement de la lecture à partir du point de lancement précédent
La commande Last lance la lecture à partir du point de lancement de la lecture
précédemment utilisé. Pour cela, sélectionnez Menu Playback → Last ou appuyez sur la
touche L.

Bouton Loop : S’allume en
jaune lorsqu’il est
sélectionné.

Point In
Les points In et Out sont
définis et la lecture en
boucle est lancée

Pré-Roll

Post-RollPoint Out

① La tête de lecture se place
au début du Pre-Roll avant
le point In et la lecture
commence.

② La tête de lecture joue les
données jusqu’à la fin du
Post-Roll, après le point
Out, puis s’arrête.

③ Selon le mode de lecture
en boucle sélectionné au
menu 210 du MX-2424, la
boucle peut se répéter
indéfiniment jusqu’à ce que
vous l’arrêtiez, se placer sur
le point 1 et s’arrêter ou
rester au point 2.

②

①
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5-6 Modes de lecture Audition
Différents modes de lecture simplifient la lecture des sections et événements audio. Ces
modes se trouvent dans le menu Playback ; des raccourcis clavier leur sont aussi affectés.

Les modes de lecture sont détaillés dans le mode d’emploi du MX-2424 : TO/PREV/REF
et FROM/NEXT/SYNC (page 23 du mode d’emploi du MX-2424).

5
&

Pour Microsoft Windows et Macintosh :
To In (Jusqu’au point In) – T suivi de I
To Out (Jusqu’au point Out) – T suivi de O
From In (Depuis le point In) – F suivi de I
From Out (Depuis le point Out) – F suivi de O
Thru In (Sur le point In) - Y suivi de I
Thru Out (Sur le point Out) - Y suivi de O

5-7 Placement de la tête de lecture selon la vue (Locate With View)
L’option Locate With View se comporte différemment si le transport est en cours ou
arrêté. Si vous sélectionnez Menu Playback → Locate With View alors que le transport
est arrêté et que vous déplacez l’affichage pour visualiser une autre section du projet, la
tête de lecture se repositionne sur la nouvelle vue et s’affiche au centre de l’écran. Par
exemple, si vous utilisez la barre de défilement inférieure pour visualiser un refrain situé
en aval, la tête de lecture suit la vue.   
Si le transport est en cours (lecture ou enregistrement) et que vous déplacez l’affichage
vers une autre section du projet, la tête de lecture continue à défiler sur sa position en
cours. Elle n’apparaît plus à l’écran, jusqu’à ce que vous reveniez à la vue manuellement
ou que vous sélectionniez l’option Return View To Playhead du menu Playback. Par
exemple, si le transport est en cours au début du projet et que vous déplacez la vue à la
fin du projet, le transport continue pendant que vous visualisez la fin du projet. En
sélectionnant Return View to Playhead, la vue de la fenêtre principale vient se replacer
sur la position de la tête de lecture.

5-8 Lecture avec Pré-Roll et Post-Roll (Pre/Post Roll On Play)
En utilisation normale, l’utilisateur doit souvent placer la tête de lecture un peu avant la
section à écouter pour bien entendre le point de départ. De même, il est souhaitable que la
lecture se prolonge un peu après la fin de la section (point Out).
Pour cela, sélectionnez la fonction “Pre/Post Roll on Play” du Menu Playback →
Pre/Post Roll On Play et vérifiez que l’option Pre-Roll (de la fenêtre de transport) est
sélectionnée avant de lancer la lecture. Le temps de Pre-Roll est utilisé par les
commandes de lecture Play et “In to Out”. Le temps de Post-Roll est uniquement utilisé

Modes de lecture du
menu Playback
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lors de la lecture d’une sélection en mode “In to Out” avec option Post-Roll sélectionnée
dans la fenêtre de transport.

5
&

Activation/Désactivation du Pre-Roll et Post-Roll : Ctrl + K sous Microsoft Windows,
Cmd + K sur Macintosh

� Note : Cette fonction est différente du Pre/Post-Roll des menus 212 et 213 tels que définis en
façade du MX-2424. Les Pre/Post-Rolls des menus 212 et 213 sont uniquement appliqués aux
modes de lecture en boucle ou audition. Les temps de Pre-Roll et de Post-Roll de la fenêtre de
transport ne modifient pas les fonctions des boutons de transport en façade du MX-2424 et ils
peuvent être utilisés avec des fonctions telles que la lecture ou la lecture “In to Out”.

5-9 Retour de la tête de lecture sur sa position de départ (Return After Play)
Lorsque vous sélectionnez l’option Return After Play dans le menu Playback, la tête de
lecture revient à son point de départ une fois le transport arrêté.

5-10 Ramener la vue sur la tête de lecture (Return View To Playhead)

Cette fonction se trouve dans le Menu View → Return View To Playhead. Elle permet
de ramener la vue sur la tête de lecture. Cette fonction s’avère très pratique lorsque le
transport est en cours et que la tête de lecture n’est pas visible à l’écran.

5
&

Ramener la vue sur la tête de lecture : Ctrl + P sous Microsoft Windows, Cmd + P sur
Macintosh

5-11 Lecture inversée
La commande de lecture inversée permet d’inverser le sens du transport, de sorte que la
tête de lecture se déplace vers la gauche de l’écran à vitesse normale. Pour lancer la

lecture inversée, cliquez sur le bouton correspondant dans la fenêtre de Transport. 

Localisation sur un projet

L’application MX-View vous permet de localiser aisément des positions d’un projet. Vous trouverez ci-
dessous les outils de localisation disponibles.

5-12 Utilisation du compteur de la tête de lecture
Le compteur de la tête de lecture situé en haut à gauche de la fenêtre de transport vous
permet de saisir une valeur et de placer la tête de lecture sur une position particulière. Il
suffit de saisir la position, comme décrit dans la section 4-8 (Utilisation des compteurs),
et d’appuyer sur la touche Enter.

5-13 Avance rapide et retour rapide
Les fonctions d’avance et de retour rapides fonctionnent comme sur un magnétophone
classique, avec la même accélération et décélération. Pour accéder à ces fonctions,
utilisez les boutons de la barre de transport ou les raccourcis clavier correspondants.

5
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Avance rapide : Ctrl + . (point) sous Microsoft Windows, Cmd + . (point) sur Macintosh.

5
&

Retour rapide : Ctrl + , (virgule) sous Microsoft Windows, Cmd + , (virgule) sur
Macintosh.

Retour rapide Avance rapide
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5-14 Placement de la tête de lecture sur le marqueur suivant/précédent
Cette fonction place directement la tête de lecture sur le marqueur de localisation suivant
ou précédent. Elle est uniquement disponible via les raccourcis clavier :

5
&

Marqueur Locate suivant : Ctrl + Ö sous Microsoft Windows, Cmd + Ö sur Macintosh.
Marqueur Locate précédent : Ctrl + Õ sous Microsoft Windows, Cmd + Õ sur Macintosh.

$
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Microsoft Windows : Pour sélectionner une région entre des marqueurs de localisation,
maintenez enfoncées les touches Shift et Ctrl et utilisez les flèches du clavier pour passer
au point de localisation suivant ou précédent.
Macintosh : Pour sélectionner une région entre des marqueurs de localisation, maintenez
enfoncées les touches Shift et Cmd et utilisez les flèches du clavier pour passer au point
de localisation suivant ou précédent.

� Note : Voir section 8-2, Utilisation des marqueurs de localisation, pour plus d’informations.

5-15 Placement de la tête de lecture sur l’édition suivante/précédente
Vous pouvez aisément faire passer la tête de lecture d’une édition à l’autre à l’aide des
raccourcis clavier Shift + Tab pour la précédente et Tab pour la suivante. Cette fonction
est également disponible via les boutons Suivant et Précédent de la fenêtre de transport.

5
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Edition suivante/précédente : Tab/Shift + Tab sur Microsoft Windows et Macintosh.

5-16 Localisation du début ou de la fin d’un projet
Pour vous placer au début d’un projet, cliquez sur le bouton Head de la fenêtre de

transport ( ). La tête de lecture se place au tout début du premier événement audio.
Pour vous placer à la fin d’un projet, cliquez sur le bouton Tail de la fenêtre de transport

( ). La tête de lecture se place ainsi à la fin du dernier événement audio.

5-17 Localisation des points In et Out
Pour placer la tête de lecture sur le point In, appuyez sur la touche “I”. Pour placer la tête
de lecture sur le point Out, appuyez sur la touche “O”.

5
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Localisation du point In : Touche I sur Microsoft Windows et Macintosh.
Localisation du point Out : Touche O sur Microsoft Windows et Macintosh.

5-18 Fonctions Roll Back et Roll Forward
Appuyez sur la virgule “,” pour que la tête de lecture recule de la valeur Roll Back
déterminée au menu 260 du MX-2424 (par défaut, cette valeur est de 5 secondes). Vous
pouvez appuyer plusieurs fois sur la touche “,” pour reculer d’autant. Par exemple, avec
la valeur par défaut de 5 secondes, vous pouvez appuyer trois fois sur la touche virgule
“,” pour que la tête de lecture recule de 15 secondes. La fonction Roll Forward permet de
faire avancer la tête de lecture. Elle fonctionne de la même manière, mais la touche à
utiliser est le point “.”. Les fonctions Roll Back et Roll Forward sont également
disponibles depuis le Menu Playback →Roll Back et Menu Playback →Roll Forward .

5
&

Roll Back : Touche “,” sur Microsoft Windows et Macintosh.
Roll Forward : Touche “.”  sur Microsoft Windows et Macintosh.

Précédente         Suivante
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� Note : Cette fonction équivaut à une double pression sur les boutons d’avance ou de retour rapide
en façade du MX-2424 ou RC-2424.

5-19 Clic dans la fenêtre principale de MX-View

A l’aide de l’outil de sélection ( ), effectuez un seul clic de la souris sur une piste dans
la fenêtre principale MX-View pour placer la tête de lecture sur cette nouvelle position.

5-20 Fenêtre Overview
Cette fenêtre affiche la totalité du projet. Elle permet une visualisation et une navigation
rapides vers toute position d’un projet. Si vous sélectionnez une région dans la fenêtre
Overview, la fenêtre principale visualise cette sélection. Un seul clic dans la fenêtre
permet de déplacer la vue dans la fenêtre principale MX-View vers la position du clic. Si
l’option Menu Playback → Locate with View est sélectionnée et que le MX-2424 n’est
pas en cours de transport, la tête de lecture se place au centre de la nouvelle vue.

La fenêtre Overview peut flotter sur l’écran et être déplacée à votre convenance. Lorsque
le transport est en cours, la section en surbrillance bleue défile avec la fenêtre Edit.

 

� Note : La fenêtre Overview ne permet pas d’effectuer des localisations durant l’enregistrement.

Outils de navigation

5-21 Zoom horizontal
Les fonctions de zoom horizontal permettent de visualiser le détail des formes d’ondes
jusqu’au niveau des échantillons. Il existe trois procédures permettant d’effectuer des
zooms avant et arrière dans la fenêtre MX-View principale : Les boutons Zoom avant et
Zoom arrière situés dans la barre d’édition, l’outil Zoom situé dans la fenêtre de transport
ou les raccourcis clavier correspondants.
• Cliquez sur les boutons Zoom avant et Zoom arrière, situés sur la barre d’édition,

pour effectuer des zooms par incréments de un niveau à chaque fois. Lorsque vous
cliquez sur ces boutons, la tête de lecture reste au centre de l’écran.

• L’outil Zoom situé dans la fenêtre de transport () permet de sélectionner la
section à agrandir. Pour effectuer un zoom avant, cliquez et faites glisser la souris

   Zoom avant        Zoom arrière

Evénements
(gris foncé)

Sélection In/Out (surbrillance bleue)

Fenêtre Overview
en position
amarrée

Fenêtre principale (cadre noir)
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autour de la zone à agrandir. Notez que cela ne modifie pas le placement de la tête de
lecture à moins que l’option “Locate with View” soit sélectionnée (Menu Playback
→ Locate with View). L’outil Zoom permet aussi d’effectuer des zooms avant et
arrière par incréments d'un niveau à chaque fois. Cliquez sur une section pour
l’agrandir (zoom avant) ou maintenez la touche Shift enfoncée tout en cliquant pour
réduire la taille d’affichage (zoom arrière).

• Les raccourcis clavier des fonctions de zoom fonctionnent comme les boutons Zoom
avant et Zoom arrière.

5
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       Zoom avant : Ctrl + [ sous Microsoft Windows ou Cmd + [ sur Macintosh.
       Zoom arrière : Ctrl + ] sous Microsoft Windows ou Cmd + ] sur Macintosh.

5-22 Visualisation de la totalité d’un projet

Pour visualiser la totalité d’un projet sélectionnez Menu View →View Whole Project.

5
&

Visualisation de la totalité d’un projet : Cmd + Shift + Z sous Microsoft Windows, Ctrl +
Shift + Z sur Macintosh.

$
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Vous pouvez aussi double-cliquer sur l’outil Zoom de la fenêtre de transport pour
visualiser la totalité d’un projet.

5-23 Visualisation des échantillons
L’application MX-View vous permet d’effectuer des zooms jusqu’au niveau des
échantillons en maintenant la touche Z enfoncée. Cela vous permet rapidement de
visualiser une édition ou une jonction. Relâchez la touche Z pour ramener la fenêtre
principale MX-View sur la vue précédente. Cette fonction est également disponible dans
le Menu View →View Samples, cependant, elle ne revient pas sur la vue précédente.

5
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Visualisation des échantillons : Touche Z sur Microsoft Windows et Macintosh.

5-24 Hauteur des pistes
Vous disposez des 10 niveaux de hauteur de piste. Pour augmenter ou diminuer la
hauteur des pistes, cliquez sur les boutons Augmenter hauteur des pistes ou Diminuer
hauteur des pistes, en haut à gauche de la barre d’édition.

5
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Augmenter hauteur des pistes : Ctrl + = (égal) sous Microsoft Windows, Cmd + = (égal)
sur Macintosh.
Diminuer hauteur des pistes : Ctrl + - (moins) sous Microsoft Windows, Cmd + - (moins)
sur Macintosh.

� Note : En mode d’enregistrement à fréquence d’échantillonnage x2 (96/88,2 kHz), le nombre de
pistes est réduit à 12 pistes.

5-25 Zoom vertical
Le zoom vertical permet d’augmenter l’amplitude des formes d’ondes afin d’accroître la
précision des éditions. Pour effectuer un zoom vertical avant ou arrière, cliquez sur les
boutons Zoom vertical avant ou arrière dans la section centrale de la barre d’édition.

   Augmenter hauteur des pistes Diminuer hauteur des pistes

Zoom vertical avant Zoom vertical arrière
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5-26 Défilement à l’aide de la souris
La souris peut être utilisée comme outil de défilement : Cliquez et déplacez le curseur
vers la gauche ou la droite dans la fenêtre principale de MX-View.

5-27 Défilement vers le haut/bas dans la fenêtre principale de MX-View
Vous pouvez faire défiler les pistes vers le haut ou vers le bas à l’aide des touches Page
précédente et Page suivante. Par exemple, si vous visualisez les pistes 9-16, le fait
d’appuyer sur la touche Page précédente permet de remonter l’affichage de la fenêtre
principale MX-View de sorte que la piste 1 soit la première piste affichée.
Pour faire remonter l’affichage de la fenêtre principale de MX-View jusqu’au début, de
sorte que la piste 1 soit visible, appuyez sur la touche Début. Pour faire défiler l’affichage
de la fenêtre principale de MX-View jusqu’à la fin, de sorte que la piste 24 soit visible,
appuyez sur la touche Fin.

� Note : Il se peut que certains ordinateurs portables ne soient pas équipés des touches Page
précédente/Page suivante et Début/Fin.

Enregistrement

5-28 Enregistrement élémentaire
Pour sélectionner une piste à enregistrer, cliquez sur le bouton d’armement en
enregistrement de cette piste de sorte qu’il clignote.

Pour lancer l’enregistrement, cliquez sur le bouton REC de la fenêtre de transport de
sorte qu’il clignote, puis cliquez sur le bouton de lecture Play. Les boutons REC et
d’armement en enregistrement s’allument alors en continu et l’enregistrement commence.

$
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Pour armer toutes les pistes en enregistrement, utilisez le bouton d’armement de toutes

les pistes , situé au-dessus des boutons d’armement en enregistrement. Ce bouton
permet également de désarmer toutes les pistes.

Pour arrêter l’enregistrement, appuyez simplement sur la barre d’espace ou cliquez sur le
bouton Stop de la fenêtre de transport. Pour arrêter l’enregistrement mais continuer la
lecture, cliquez sur le bouton Play de la fenêtre de Transport. Vous pouvez aussi
désarmer des pistes individuelles en cliquant une fois sur le bouton d’armement en
enregistrement de la piste souhaitée.

5
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Enregistrement : Ctrl + Barre d’espace sous Microsoft Windows, Cmd + Barre d’espace sur Macintosh.

5
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Arrêt : Barre d’espace sous Microsoft Windows et sur Macintosh.

5
&

Arrêt de l’enregistrement et poursuite de la lecture : Ctrl + Barre d’espace sous Microsoft
Windows et sur Macintosh.

Armement en
enregistrement

Les boutons Play et REC sont tous deux allumés en continu lorsque le MX-2424
est en enregistrement



38

$
VWXFH

Pour annuler un enregistrement, il suffit de cliquer sur le bouton d’annulation  de la
barre d’édition. Consultez la section 6-25 pour plus de détails sur les fonctions
d’annulation et de rétablissement.

5-29 Enregistrement automatique et répétition automatique
Le mode d’enregistrement automatique déclenche l’enregistrement lorsque la lecture
atteint le point In et arrête l’enregistrement au point Out pour reprendre la lecture. Pour
réaliser un enregistrement automatique, vous devez d’abord définir les points In et Out.
Armez en enregistrement les pistes souhaitées et cliquez sur le bouton Auto suivi du
bouton REC dans la fenêtre de transport. A ce stade, les boutons d’armement en
enregistrement et le bouton REC doivent clignoter en rouge et le bouton Auto doit être
allumé en rouge continu :  .

Placez la tête de lecture avant le point In à votre convenance et cliquez sur Play.
L’enregistreur se met en lecture et passe en enregistrement au point In. Au point Out,
l’enregistrement s’arrête et le multipiste repasse en lecture. Vous devez appuyer sur Stop
pour arrêter le transport.

Le mode de répétition automatique fonctionne de la même manière, mais au lieu de
passer en enregistrement, le MX lit les données reçues en entrée, ce qui vous permet de
pré-écouter l’enregistrement. Pour activer le mode de répétition automatique, cliquez
d’abord sur Auto puis sur le bouton de Répétition REH.  Le bouton REH clignote en
jaune et le bouton Auto s’allume en jaune. Pour lancer la répétition automatique, appuyez
sur Play.

Pour quitter le mode de répétition ou d’enregistrement automatique, cliquez une fois sur
le bouton Auto.

� Note : Vous pouvez utiliser le mode d’enregistrement automatique avec Pre- et Post-Roll pour
faciliter l’enregistrement par Punch-In/Out.

4
.

Mode d’enregistrement/répétition automatique : Ctrl + Shift + A sous Microsoft
Windows, Cmd + Shift + A sur Macintosh.

5-30 Enregistrement en boucle
L’application MX-View propose plusieurs modes de mise en boucle :
• Lecture répétée (par défaut) : Ce mode enregistre continuellement sur les

 données audio existantes, sans s’arrêter.
• Lecture unique puis arrêt : Ce mode enregistre une seule fois, puis s’arrête après

 au niveau du Post-Roll après le point Out.
• Lecture unique puis écoute : Ce mode enregistre une seule fois, puis place la tête

 de lecture au niveau du Pre-Roll, avant le point In.

Pour plus de détails sur ces fonctions, consultez le menu Bank 200 : section des réglages
système du mode d’emploi du MX-2424 (page 38).

Avant d’effectuer un enregistrement en boucle, vous devez d’abord choisir le mode de
mise en boucle souhaité dans le menu 210 du MX-2424. Ensuite, définissez les points In
et Out à votre convenance, armez en enregistrement les pistes souhaitées et cliquez sur le
bouton Auto de la fenêtre de transport. Le bouton Auto doit maintenant être allumé en
rouge (en continu). Appuyez sur le bouton REC de la fenêtre de transport de sorte qu’il

Auto (Jaune continu)

Répétition (Jaune clignotant)
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clignote, ainsi que les pistes armées en enregistrement. Cliquez sur le bouton Loop de la
fenêtre de transport pour lancer l’enregistrement en boucle. Les boutons de la fenêtre de
transport sont alors allumés comme illustré ci-dessous :

Notez que vous pouvez également réaliser une boucle de répétition de la même manière,
simplement le bouton REH doit être armé à la place du bouton REC.

4
.

Boucle : Ctrl + L sous Microsoft Windows, Cmd + L sur Macintosh.

Enregistrement en boucle avec déchargement automatique (Auto Unload)
La fonction Auto Unload décharge automatiquement une piste afin que vous puissiez
effectuer un nouvel enregistrement sans supprimer la prise précédente. L’enregistrement
en boucle, configuré au menu 211 du MX-2424, alterne entre Auto Unload activé (On) ou
désactivé (Off). Ce mode est particulièrement utile lorsque vous souhaitez enregistrer la
meilleure prise sans effacer les prises précédentes.

5-31 Synchronisation externe
Tandis que la plupart des paramètres de synchronisation externe des enregistreurs
MX-2424 et MM se trouvent dans les réglages Machine Settings, de nombreuses
caractéristiques essentielles se règlent dans la barre Machine Info et dans la fenêtre de
transport. Lorsque le transport est synchronisé sur un appareil externe, le bouton Online
doit être activé. Le bouton Online se trouve en bas à gauche de la fenêtre de transport et il

s’allume en jaune lorsqu’il est activé ( ).
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Opt + Cliquer (sur Macintosh) ou Alt + Cliquer (Microsoft Windows) sur le bouton
Online pour activer tous les appareils valides en ligne.

La barre Machine Info contient une brève présentation des réglages importants de
l’appareil. De plus, cette barre vous permet de visualiser le Time Code reçu, de régler les
Offsets de bus et de Time Code et de visualiser l’espace disque disponible pour
l’enregistrement. Pour visualiser ou modifier ces réglages, ouvrez le menu déroulant situé
à droite de la LED Busy.

Les Offsets de Bus et TC peuvent être définis grâce au compteur situé à droite du menu
déroulant (comme décrit dans la section 4-8), tandis que les compteurs d’espace disque
disponible (Free Space) et de Time Code reçu (TC Reader) sont en lecture uniquement.

5-32 Options de visualisation (menu View)
Préchargement de toutes les formes d’ondes

Bouton REC allumé en rouge

Bouton Auto allumé en rouge

Transport en lecture

Bouton Loop allumé en
jaune

Menu déroulant Compteur

Cliquez pour
sélectionner
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L’option Preload All Waveforms du menu View est destinée aux utilisateurs avancés.
Aux niveaux de zoom généralement utilisés en cours de travail, MX-View dispose de
toutes les informations nécessaires à l’affichage des formes d’ondes. Toutefois, lorsque
vous zoomez plus avant, il se peut que MX-View ne dispose plus des informations
suffisantes et doive les charger “à la volée” depuis le MX-2424. Cela s’effectue souvent
très rapidement, avec un léger retard dû au chargement des données manquantes par
MX-View. Cependant, lorsque vous zoomez plus avant et que le MX-2424 est en cours
de transport, il se peut que les formes d’ondes disparaissent et réapparaissent
fréquemment. Le cas échéant, l’option Preload All Waveforms permet à l’application
MX-View de charger toutes les données de formes d’ondes du projet depuis le MX-2424.
Ce procédé élimine l’inconstance des formes d’ondes mais il prend beaucoup de temps et
consomme beaucoup d’espace disque sur l’ordinateur utilisant MX-View.

Sous-images
Lorsque vous sélectionnez l’option Subframes du menu View, les deux chiffres des sous-
images sont ajoutés aux compteurs de MX-View.

Option Feet/Frames (N/C)
Cette option sera disponible dans une mise à jour ultérieure.

Points de jonction
Lorsque vous activez l’option Splice Points du menu View, des lignes se placent sur les
points de départ et de fin de chaque événement audio. Les points de jonction marquent
plus nettement la séparation entre les événements, ce qui permet plus aisément de
différencier les événements rapprochés.

Sous-images

Option
Splice Points
désactivée

Option
Splice Points
activée

Point de
jonction
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Chapitre 6 : Edition

Le Chapitre 6 explique de manière approfondie les fonctions d’édition fondamentales, dont la sélection
d’une région, les fonctions de couper, copier, coller, etc.  Pour pouvoir utiliser ces commandes et fonctions,
l’icône d’édition des événements doit être sélectionnée (dans la barre d’édition).

 

6-1 Sélection d’une région à éditer
Avant toute édition, une région audio doit être sélectionnée. Il existe plusieurs manières
de sélectionner une région : à l’aide de l’outil de sélection, de l’outil Drag and Trim, ou
par sélection individuelle des boutons d’édition des pistes et des points In et Out.

Outil de sélection
L’outil de sélection situé dans la fenêtre de transport () peut être utilisé pour
sélectionner des régions à éditer. Pour sélectionner une région, cliquez-déplacez le
curseur sur la région souhaitée. Les points In et Out sont automatiquement définis et les
boutons d’édition des pistes sont automatiquement activés lors de la sélection de la
région.

Pour ajouter une piste à éditer parmi un groupe de pistes déjà sélectionnées, maintenez la
touche Shift enfoncée tout en cliquant sur les pistes souhaitées. Pour désélectionner une
piste, maintenez la touche Shift enfoncée et cliquez une fois sur la piste sélectionnée ; ou
maintenez la touche Ctrl enfoncée et cliquez sur la piste sélectionnée. Vous pouvez aussi
ajouter ou retirer des pistes du groupe d’édition en sélectionnant ou désélectionnant les

boutons d’édition de piste correspondants ().

Il est possible d’étendre une région déjà sélectionnée en maintenant la touche Shift
enfoncée et en effectuant un cliquer-déplacer sur la région souhaitée. Pour désélectionner
une partie de la région sélectionnée, effectuez un Ctrl + Clic + Déplacer. Vous pouvez
annuler une sélection par déplacement (si la souris est toujours enfoncée) à l’aide de la
touche Esc (Echappe). Vous trouverez une liste des raccourcis clavier de l’outil de
sélection dans l’Annexe A.
*

$
VWXFH

Pour désélectionner toutes les pistes à éditer tout en conservant les points In et Out,
utilisez la fonction Deselect All (Désélectionner tout) du menu Edit ou la touche Esc.

Bouton
d’édition de
piste armé

Région audio
sélectionnée

Points In et Out
automatiquement
définis

Edition des événements
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Outil de déplacement/réglage des événements (Drag and Trim)

L’outil Drag and Trim situé dans la fenêtre de transport () peut être utilisé pour
sélectionner un événement ou un groupe d’événements et les déplacer vers une nouvelle
position. Pour sélectionner un seul événement, il suffit de cliquer une fois dessus. Pour
sélectionner un groupe d’événements, maintenez la touche Shift enfoncée et cliquez sur
les événements souhaités. Lorsque vous sélectionnez des événements, les points In et Out
sont automatiquement définis et les boutons d’édition des pistes automatiquement armés.
Pour désélectionner un événement, maintenez la touche Shift enfoncée et cliquez sur
l’événement sélectionné ; ou maintenez la touche Ctrl et cliquez sur l’événement
sélectionné.

Vous pouvez sélectionner des événements supplémentaires en maintenant la touche Shift
enfoncée, en cliquant sur une zone vide et en déplaçant le curseur sur les événements
supplémentaires souhaités. Vous pouvez utiliser la même méthode pour désélectionner
des événements, mais en maintenant la touche Ctrl enfoncée.
Pour sélectionner des événements, vous pouvez aussi cliquer sur une région vide et
déplacer le curseur sur un événement ou un groupe d’événements. Utilisez la touche Esc
pour annuler une sélection par cliquer-déplacer. 

Boutons
d’édition des
pistes armés

Région audio
sélectionnée

Notez que les
régions vides
peuvent également
être sélectionnées

Points In et
Out

1 Commencer à
glisser depuis une
région vide

2 Fin du glissement
(relâcher la souris)

Région audio
sélectionnée

1

2
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Boutons d’édition des pistes et points In/Out
Pour sélectionner une piste à éditer, cliquez sur le bouton d’édition de la piste concernée.

Le bouton d’édition s’allume alors en jaune . Ensuite, définissez les points In et Out
comme décrit dans la section 4-9. La région sélectionnée s’affiche en surbrillance.

$
VWXFH

Pour armer ou désarmer toutes les pistes à éditer, cliquez sur le bouton Edit All (Editer

tout) situé au-dessus du bouton d’édition de la piste 1 ().

Notez que lorsque l’ordinateur est en cours d’activité, le curseur de la souris prend la

forme suivante : .

6-2 Forcer la sélection d’une région
Lorsque vous sélectionnez une région entourée d’événements (comme illustré ci-dessous) à l’aide
de l’outil Drag and Trim, vous devez forcer la sélection pour éviter de déplacer les événements.

A l’aide de l’outil Drag and Trim, maintenez la touche R enfoncée et cliquez-glissez à
gauche du premier événement à sélectionner. Un rectangle de sélection apparaît en
surbrillance lorsque vous relâchez la souris.

� Note : Il est inutile de forcer la sélection lorsque vous utilisez l’outil de sélection.

5
&

Sélection forcée d’une région : R + Clic + Glisser sur l’événement sous Microsoft
Windows et sur Macintosh.

Région
sélectionnée
pour l’édition

Piste
sélectionnée
pour l’édition

Points In et Out
sélectionnés pour
l’édition

Sélection forcée des
événéments (en blanc).
Notez que les événements
sont  totalement entourés
d’autres événements.
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$
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La sélection d’une région peut être combinée à la touche Shift pour ajouter des
événements ou à la touche Ctrl pour supprimer des événements de la sélection existante.

6-3 Couper
La fonction couper permet de supprimer des données audio entre les points In et Out et de faire
glisser toutes les données audio en aval vers la gauche. Pour couper des données, sélectionnez la
région souhaitée, puis cliquez sur Couper dans la barre d’édition ou sélectionnez Cut dans le
menu Edit. Toute région audio coupée est sauvegardée dans le presse-papier.

Avant :

Après :

5
&

Couper : Ctrl + X sous Microsoft Windows, Cmd + X sur Macintosh.

6-4 Coupe locale
La fonction de coupe  locale déplace uniquement l’événement associé à l’édition. Les données
audio associées à l’édition sont déplacées vers la gauche, comme illustré ci-dessous :

Avant :

Après :

5
&

Coupe locale : Ctrl + Shift + S sous Microsoft Windows, Cmd + Shift + S sur Macintosh.

Données audio
sélectionnées à copier

Les événements non associés
à l’événement édité ne sont
pas modifiés

Création automatique
d’un Fade

Partie droite de l’événement glissée vers la gauche

Données audio
sélectionnées à couper

Les événements en aval
glissent vers la gauche
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6-5 Coupe à gauche
La coupe gauche fait glisser vers la droite toutes les données situées à gauche de
l’édition, comme illustré ci-dessous.

Avant :

Après :

5
&

Coupe à gauche : Ctrl + Shift + X sous Microsoft Windows, Cmd + Shift + X sur Macintosh

6-6 Coupe locale à gauche
La coupe locale à gauche est une coupe à gauche qui déplace uniquement l’événement
associé à l’édition. Les données audio associées à l’édition se déplacent vers la droite.

Avant :

Données audio
sélectionnées pour
la coupe locale à
gauche

Données audio
sélectionnées à couper

Tous les événements à
gauche de l’édition
glissent vers la droite
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Après :

5
&

Coupe locale gauche : Ctrl + Shift + D sous Microsoft Windows, Cmd + Shift + D sur Macintosh.

6-7 Copier
La fonction Copier permet de placer dans un emplacement du presse-papier les données
audio sélectionnées, définies par les points In et Out et les boutons d’édition des pistes.
Le contenu du presse-papier peut alors être collé ou inséré dans des pistes audio. Pour
réaliser une copie, sélectionnez des données audio, puis cliquez sur le bouton Copier de la
barre d’édition ou sélectionnez la fonction Copy dans le menu Edit.

� Note : MX-View dispose de quatre emplacements de presse-papier. Pour plus de détails sur leur
utilisation, veuillez vous référer à la section 7-9.

5
&

Copier : Ctrl + C sous Microsoft Windows, Cmd + C sur Macintosh.

6-8 Coller
Pour toute commande Coller, les données doivent d’abord avoir été copiées dans le
presse-papier. Lorsque vous avez défini le point In, vous pouvez coller ces données. La
fonction Coller place le contenu du presse-papier sélectionné au point In, remplaçant les
données audio qui se trouvent en aval.

Avant :

La partie gauche de l’événement
glisse  vers la droite

Les événements non associés à
l’événement édité ne sont pas
modifiés

Région audio
sélectionnée et copiée
dans le presse-papier

Région
sélectionnée
pour la copie

Notez qu’une
région vide est
également
copiée
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Après :

4
.

Coller : Ctrl + V sous Microsoft Windows, Cmd + V sur Macintosh

6-9 Coller à gauche
La commande Coller à gauche est similaire à la commande Coller, mais elle remplace les
données situées à gauche du point In.

Avant :

Après :

5
&

Coller à gauche : Ctrl + Shift + L sous Microsoft Windows, Cmd + Shift + L sur
Macintosh

La région audio est collée,
remplaçant les données
audio existantes à droite
du point In

Un nouveau point In est
sélectionné

Région audio sélectionnée
et copiée dans le presse-
papier

La région audio est collée,
remplaçant les données
existantes à gauche du
point In

Point In
sélectionné
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6-10 Coller sur la position de la tête de lecture
Cette commande d’édition place le point In au niveau de la tête de lecture et colle le
contenu du presse-papier sur ce point.

Avant :

Après :

4
.

Coller sur la position de la tête de lecture : Ctrl + Shift + P sous Microsoft Windows,
Cmd + Shift + P sur Macintosh

6-11 Supprimer
La commande Supprimer supprime les données audio situées entre les points In et Out,
sans faire glisser les événements audio. La région supprimée est sauvegardée dans le
presse-papier.

Avant :

Région audio
sélectionnée et
copiée dans le
presse-papier

Tête de
lecture

La région audio est
collée à droite de la
tête de lecture,
remplaçant les
données audio situées
en aval

Tête de
lecture

Région audio
sélectionnée
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Après :

5
&

Supprimer : Ctrl + B ou Delete/Backspace (<-) sous Microsoft Windows, Cmd + B ou
Delete/Backspace sur Macintosh

6-12 Ouvrir
La commande Ouvrir déplace les données audio situées entre les points In et Out vers la
droite, laissant du silence entre les points In et Out.

Avant :

Après :

5
&

Ouvrir : Ctrl + H sous Microsoft Windows, Cmd + H sur Macintosh

Région audio
supprimée. Les autres
événements ne
sont pas déplacés.

Région audio
sélectionnée
pour la
commande
Ouvrir

L’édition ouvre une
zone vide entre les
points In et Out,
déplaçant les données
audio vers la droite
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6-13 Insérer
La commande Insérer place les données audio du presse-papier sur le point In et déplace
les données audio vers la droite.

Avant :

Après :

5
&

Insérer : Ctrl + I sous Microsoft Windows, Cmd + I sur Macintosh

Région audio
sélectionnée et
copiée dans le
presse-papier

Points In et Out sélectionnés
pour l’insertion

Evénement audio inséré,
déplaçant les autres
événements audio vers la
droite
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6-14 Fonction Repeat Selection
Deux types de fonctions de répétition sont disponibles, Repeat Paste et Repeat Insert.
Pour utiliser la fonction Repeat Paste ou Insert, déterminez les points In et Out, puis
sélectionnez Menu Edit → Repeat Selection. Notez qu’il n’est pas nécessaire
d’effectuer une copie pour la fonction Repeat, car les données répétées ne passent pas par
le presse-papier. Saisissez le nombre de répétitions des données audio (champ Count) et
sélectionnez Paste ou Insert. Avec la fonction Repeat Paste, les données collées à
répétition remplacent les données audio existantes.

Avant :

 

Après :

Nombre de
répétitions de
la région audio

Option Repeat Insert. Par
défaut, cette option n’est pas
sélectionnée et la fonction
Repeat Paste est en vigueur

Région audio
sélectionnée pour la
répétition. Notez qu’il
n’est pas nécessaire
de copier cette région
dans le presse-papier.

Nombre de répétitions
du collage des données
(20 dans cet exemple).

Région répétée 20 fois,
remplaçant les
données  existantes
en aval.
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La fonction Repeat Insert est similaire à la fonction Repeat Paste, mais elle déplace les
données audio en aval au lieu de les remplacer.

Avant :

Après:

5
&

Répétition : Ctrl + R sous Microsoft Windows, Cmd + R sur Macintosh

6-15 Diviser
La commande Split sépare ou “divise” un événement audio en deux au niveau de la tête
de lecture.

Avant :

La région audio est insérée
5 fois, déplaçant les
données existantes vers la
droite.

Région audio
sélectionnée pour
la répétition

Nombre
d’insertions : 5

La tête de lecture est
positionnée pour la
commande Diviser
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Après :

5
&

Diviser : Ctrl + E sous Microsoft Windows, Cmd + E sur Macintosh

$
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Le fait d’activer les points de jonction (Menu View → Splice Points) crée une ligne de
séparation plus prononcée entre les événements, ce qui permet plus facilement de
visualiser les éditions Diviser, Séparer ou Isoler.

6-16 Séparer
La commande Séparer est similaire à la commande Split car elle sépare un événement
audio. Cependant, la commande Séparer effectue une “division” au niveau des points In
et Out, séparant un événement audio en trois événements.

Avant :

Après :

5
&

Séparer : Ctrl + U sous Microsoft Windows, Cmd + U sur Macintosh

6-17 Isoler
La commande Isoler supprime les données audio qui entourent les points In et Out, sans
modifier les autres événements audio.

La division est exécutée,
créant deux événements
séparés par un Crossfade

L’événement audio est
séparé au niveau des
points In et Out

Région audio
sélectionnée
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Avant :

Après :

4
.

Isoler : Ctrl + T sous Microsoft Windows, Cmd + T sur Macintosh

6-18 Fonction Sync Paste
L’une des différences essentielles entre la fonction Sync Paste et la fonction Paste
normale est qu’il n’est pas nécessaire de sélectionner un point In pour exécuter la
fonction Sync Paste. En revanche, la tête de lecture est déplacée et les données audio du
presse-papier sont collées au point In calculé par rapport à la tête de lecture. En d’autres
termes, le collage des données est décalé de la distance qui sépare la tête de lecture du
point In. Pour exécuter une commande Sync Paste, vous devez d’abord copier les
données audio dans le presse-papier, en notant où se trouve le point In par rapport à la
tête de lecture. Placez la tête de lecture sur la position souhaitée et exécutez la commande
Sync Paste.

Avant :

L’isolation est exécutée, supprimant
les données audio situées à gauche et
à droite de l’événement.

Région audio
sélectionnée

La région audio
sélectionnée est
copiée dans le
presse-papier

Notez la distance entre
le point In et la tête de
lecture
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Après :

5
&

Sync Paste : Ctrl + Shift + V sous Microsoft Windows, Cmd + Shift + V sur Macintosh

� Note : Sur le MMR, l’option Sync at Playhead doit être activée.

6-19 Fonction Sync Insert
La fonction Sync Insert est similaire à la fonction Sync Paste car l’édition est également
référencée sur la position de la tête de lecture. Cependant, avec la fonction Sync Insert, la
région audio insérée ne remplace pas les données audio existantes. Elle est simplement
insérée, décalant les données existantes vers la droite.

5
&

Sync Insert : Ctrl + Shift + I sous Microsoft Windows, Cmd + Shift + I sur Macintosh

$
VWXFH

Les fonctions Sync Insert et Sync Paste sont très pratiques pour l’édition d’événements
sur de la vidéo, comme placer le son d’un coup de feu sur la séquence vidéo d’une arme
en cours de tir. Il suffit de placer la tête de lecture sur la crête de l’événement audio du
coup de feu et d’effectuer une opération Sync Paste en plaçant la tête de lecture sur
l’image d’une arme en cours de tir. D’autres applications permettent également de placer
un son de batterie sur un passage vide.

6-20 Nudge
La valeur Nudge décale les données audio d’une valeur préprogrammée, déterminée dans
le compteur Nudge de la fenêtre de transport.

Les données audio peuvent être décalées plusieurs fois vers la gauche ou la droite à l’aide des
touches + (plus) et – (moins). Les données décalées remplacent les événements audio existants.

La tête de lecture
est déplacée

La fonction Sync
Paste est
exécutée,
remplaçant les
données audio en
aval

Notez que la région
collée présente
exactement la même
distance entre le point In
et la tête de lecture
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Pour appliquer un Nudge, sélectionnez une région audio. Appuyez sur la touche + (plus)
pour décaler les données audio vers la droite et sur la touche – (moins) pour les décaler
vers la gauche.

Avant :

Après un Nudge vers la droite :

Après un Nudge vers la gauche :

Un Nudge effectue automatiquement une division au niveau des points In et Out si ces
points se trouvent à l’intérieur d’un événement audio.

5
&

Nudge vers la droite : + (plus) ou = (égal) sous Microsoft Windows, + (plus) ou = (égal)
sur Macintosh
Nudge vers la gauche : - (moins) sous Microsoft Windows, - (moins) sur Macintosh

Région audio
sélectionnée

Un Nudge vers la droite est
exécuté, déplaçant
l’événement sélectionné
vers la droite selon la
valeur Nudge. Notez
qu’une édition Séparer est
automatiquement réalisée
au niveau des points In et
Out.

Un Nudge vers la
gauche est exécuté,
déplaçant l’événement
sélectionné vers la gauche
selon la valeur Nudge.
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6-21 Point In sur la position de la tête de lecture (“In to Now”)
Cette fonction effectue d’abord une édition Séparer aux points In et Out définis (si
nécessaire), puis elle colle l’événement sur la position de la tête de lecture. Pour exécuter
cette fonction, sélectionnez les points In et Out, en vous assurant que le bouton d’édition
des pistes concernées est activé. Placez la tête de lecture sur la position où vous souhaitez
placer les données audio sélectionnées, puis sélectionnez “In to Now” dans le menu Edit.

Avant :

Après :

5
&

“In to Now” : Ctrl + M sous Microsoft Windows, Cmd + M sur Macintosh

6-22 Renommer les événements
Pour affecter un nouveau nom à un événement audio, double-cliquez sur cet événement à
l’aide de l’outil Drag and Trim. Une fenêtre affiche en surbrillance le nom existant, vous
permettant de modifier ce nom.

� Note : Lorsque vous renommez un événement, cela ne modifie pas le nom du fichier audio se
trouvant sur le disque.   

Région audio
sélectionnée

Tête de lecture

La région audio
sélectionnée est
coupée puis collée
sur la position de la
tête de lecture
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6-23 Fonction de fusion des événements
La fonction Render permet de créer un événement audio continu, ce qui s’avère très
pratique pour augmenter les performances du disque. A l’instar de la fonction TapeMode
Convert, la commande Render utilise les points In et Out comme points de départ et de
fin. La fonction Render peut s’appliquer à des événements d’une même piste ou de
plusieurs pistes. Lorsque la fonction est exécutée, le nouvel événement “fusionné”
remplace les événements audio existants.

Pour exécuter la fonction Render, sélectionnez les événements souhaités et sélectionnez
Render dans le menu Edit. Selon la durée et le nombre de pistes sélectionnées, il se peut
que la procédure de fusion dure quelques minutes. Le curseur d’activité de l’ordinateur
s’affiche durant cette procédure.

Avant :

Après :

5
&

Render : Ctrl + Shift + R sous Microsoft Windows, Cmd + Shift + R sur Macintosh

� Note : La commande Render tient compte de l’automation du volume et du Mute. Le fichier audio
qui vient d’être fusionné reflète les variations de volume.

Région audio
sélectionnée

La région audio est
fusionnée. Notez que les
espaces vides entre les
événements sont
également fusionnés.
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6-24 Inversion des événements
La fonction Reverse “inverse” un événement ou une région audio, comme si ces données
audio étaient lues à l’envers, mais sans modifier les pistes non sélectionnées. Le nouvel
événement audio inversé remplace la région audio existante. Pour effectuer une inversion,
sélectionnez la région ou les événements audio souhaités, puis sélectionnez la fonction
Reverse du menu Edit. Selon la durée et le nombre des pistes sélectionnées, il se peut que
l’inversion dure quelques minutes. Le curseur d’activité s’affiche durant cette procédure.

Avant :

Après :

6-25 Annulation et rétablissement
Le MX-2424 dispose de 99 niveaux d’annulation. Cela signifie qu’il peut annuler les
99 dernières éditions ou enregistrements réalisés. Les annulations sont uniquement
possibles sur le projet en cours. Vous ne pouvez pas effectuer d’annulation sur un projet
précédent. Les annulations ne sont pas sauvegardées avec le projet. La liste des annulations
est supprimée à chaque fois que vous lancez un nouveau projet, que vous démontez un
disque ou que vous placez le multipiste hors tension. Cliquez sur la touche Rétablir pour
annuler une annulation. Les fonctions d’annulation et de rétablissement sont disponibles
dans la barre d’édition, le menu Edit (Undo et Redo) ou sous forme de raccourcis clavier.

5
&

Annuler : Ctrl + Z sous Microsoft Windows, Cmd + Z sur Macintosh
Rétablir : Ctrl + Y sous Microsoft Windows, Cmd + Y sur Macintosh

� Note : Le MMR est limité à 10 niveaux d’annulation.

6-26 Edition par glisser-déposer
L’édition par glisser-déposer permet d’éditer et de déplacer aisément les événements
audio à l’aide de la souris et de différents raccourcis clavier. Tandis que l’outil de
sélection permet surtout de sélectionner des régions audio, l’outil Drag and Trim permet
de modifier la durée des événements et des Fades, de déplacer les événements audio,
d’insérer et d’éditer des points d’automation du volume et de déplacer les marqueurs de
localisation (l’automation du volume par points d’édition et le réglage des Fades sont
détaillés dans le Chapitre 7).

Evénement audio
sélectionné

L’édition inversée
est exécutée : la
forme d’onde est
inversée.
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6-27 Principes d’utilisation de l’outil Drag and Trim
Pour déplacer un seul événement, cliquez dessus et glissez-le vers la position souhaitée.
Pour déplacer un groupe d’événements, cliquez sur le premier des événements, puis
maintenez la touche Shift enfoncée et cliquez sur les autres événements du groupe, enfin,
faites glisser le groupe sélectionné vers la position souhaitée. Notez que lorsque vous
sélectionnez plusieurs événements, seul le dernier événement sélectionné dispose de
poignées, même si la commande de modification de la durée s’applique à tous les
événements sélectionnés. La procédure de modification de la durée des événements est
détaillée dans le Chapitre 7.

L’outil Drag and Trim permet aussi d’accéder à des fonctions plus complètes. Tout en
maintenant la touche Alt enfoncée, cliquez sur un événement pour le faire glisser. Cela
crée une copie de l’événement, au lieu de le déplacer. Pour le coller, il suffit de relâcher
la souris.

En maintenant la touche Ctrl enfoncée durant l’édition par glisser-déposer, vous pouvez
déplacer les événements audio verticalement d’une piste à l’autre, sans les déplacer
horizontalement. Cela s’avère particulièrement pratique lorsque vous souhaitez déplacer
des données audio vers une autre piste tout en conservant la synchronisation.

5
&

Il est possible de changer temporairement d’outil grâce à différents raccourcis clavier. Le
changement temporaire dure tant que vous maintenez la touche F6 ou F7 enfoncée.
Lorsque vous relâchez la touche, le mode d’édition revient à son statut précédent.
• Avec l’outil Drag and Trim, maintenez la touche F6 enfoncée pour passer

temporairement à l’outil de sélection.
• Avec l’outil Drag and Trim, maintenez la touche F7 enfoncée pour passer

temporairement à l’outil Zoom.
• Avec l’outil de sélection, maintenez la touche F6 enfoncée pour passer

temporairement à l’outil Drag and Trim.
• Avec l’outil de sélection, maintenez la touche F7 enfoncée pour passer

temporairement à l’outil Zoom.
• Les touches F6 et F7 peuvent être considérées comme des sélecteurs vers la gauche

et vers la droite, respectivement, alternant temporairement entre les trois principaux
outils de la fenêtre de transport : l’outil de sélection, l’outil Drag and Trim et l’outil
Zoom.
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Chapitre 7 : Edition avancée

Ce chapitre traite des fonctions d’édition avancées, dont les réglages de durée, de volume et de Fade des
événements, la création de Fades et de Crossfades et l’utilisation de plusieurs presse-papiers.

7-1 Principes de réglage des événements
Pour régler les paramètres d’un événement, cliquez une fois dessus avec l’outil Drag and
Trim. L’événement est sélectionné et présente sept poignées, comme illustré ci-dessous.

� Note : Lorsque vous sélectionnez un événement à l’aide de l’outil de sélection, la sélection entre
les points In et Out s’effectue en bleu. En outre, il n’est pas possible de régler la durée, le volume
ou les Fades d’un événement à l’aide de l’outil de sélection.

7-2 Réglage horizontal
Le réglage horizontal modifie la durée de l’événement, sans le déplacer sur l’axe
temporel. Pour régler la durée d’un événement audio, cliquez une fois sur l’événement de
manière à afficher les poignées de réglage. Placez le curseur de la souris sur les poignées
horizontales, de sorte que le curseur de réglage apparaisse (↔). Cliquez et faites glisser le
curseur vers la gauche ou la droite, puis relâchez la souris lorsque vous avez atteint la
durée souhaitée.

Avant :

Poignées horizontales
de réglage de la durée

Poignées de réglage
des Fades

Poignées verticales de
réglage du volume

La poignée horizontale
gauche est déplacée vers la
gauche

Lignes de départ et
de fin (In et Out)
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Après :

� Note : Il n’est pas possible d’étendre un événement au-delà de la durée du fichier enregistré auquel
il est associé. Si vous tentez de faire glisser le curseur de réglage vers la gauche ou la droite et qu’il
reste bloqué, cela signifie que vous avez atteint la limite du fichier audio.

7-3 Réglage de la durée de plusieurs événements
Pour régler la durée de plusieurs événements à la fois, maintenez la touche Shift enfoncée
et sélectionnez les événements à l’aide de l’outil Drag and Trim. Vous pouvez aussi
utiliser l’outil Drag and Trim pour effectuer une édition par cliquer-glisser sur la zone
comprenant les événements à sélectionner. Notez que seul le dernier événement
sélectionné dispose de poignées de réglage, mais tous sont placés en surbrillance.
Ensuite, utilisez les poignées du dernier événement sélectionné pour régler
simultanément la durée de tous les événements sélectionnés.

Avant :

 

Après :

La poignée de réglage est relâchée et l’événement est étendu
vers la gauche. Notez que le point Out n’est pas modifié.

Premier
événement
sélectionné

Dernier événement
sélectionné. Les
poignées de réglage
apparaissent sur cet
événement.

Le premier événement
sélectionné est
également déplacé vers
la droite

Le dernier événement
sélectionné est déplacé
vers la droite
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7-4 Modification de la durée d’un événement avec déplacement des données
 adjacentes

Cette fonction consiste à régler la durée d’un événement sélectionné en faisant glisser les
données audio adjacentes vers la droite ou vers la gauche, selon le sens du réglage. Pour
appliquer cette fonction, maintenez la touche Alt enfoncée, puis cliquez sur la poignée
pour faire glisser la sélection.

Avant :

Après :

5
&

Modification de la durée d’un événement avec déplacement des données adjacentes : Alt
+ Cliquer + Déplacer la poignée sous Microsoft Windows et sur Macintosh

7-5 Extension jusqu’à l’événement suivant
Cette fonction étend automatiquement la durée de l’événement sélectionné jusqu’à
l’événement suivant sur la piste. Pour exécuter cette fonction, sélectionnez l’événement
souhaité, maintenez la touche Shift enfoncée et faites légèrement glisser la poignée.
Relâchez la souris. Le bord déplacé de l’événement sélectionné se magnétise
automatiquement sur le début de l’événement suivant, de sorte que leurs bords se touchent.

Avant :

Après :

Evénement
sélectionné

L’événement est
étendu vers la
droite alors que la
touche Alt est
enfoncée

Les événements en aval
sont décalés vers la droite
en conséquence

La même distance est
conservée entre les
événements

L’événement sélectionné
est légèrement déplacé
vers la droite tandis que la
touche Shift est enfoncée

L’événement sélectionné se magnétise sur le suivant
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5
&

Extension d’un événement jusqu’au suivant : Shift + Cliquer + Déplacer la poignée sous
Microsoft Windows et sur Macintosh

7-6 Fonction Lock Trim
Lorsque deux événements adjacents sont sélectionnés, une poignée de réglage rouge
apparaît entre les deux événements, comme illustré ci-dessous. Cette poignée de réglage
permet de déplacer le bord partagé par les deux événements. Pour exécuter cette fonction,
sélectionnez d’abord deux événements adjacents. Faites ensuite glisser la poignée rouge
située sur le bord partagé des événements, puis relâchez la souris quand vous le souhaitez.

Avant :

Après :

7-7 Réglage du volume des événements
Sur MX-View, deux méthodes permettent de modifier le volume des données audio :
l’automation du volume par points d’édition et le réglage du volume à l’aide des poignées
de réglage. L’automation du volume, détaillée dans la section 8-4, implique la création et
le déplacement de points d’édition afin de faire varier le volume d’une piste. Il s’agit de
la plus souple des deux méthodes. Le réglage du volume à l’aide des poignées de réglage
est une méthode rapide vous permettant de modifier le volume d’un événement ou d’un
groupe d’événements. Notez que ces deux méthodes peuvent être utilisées
simultanément.

Deux événements
adjacents
sélectionnés
partageant une
poignée de
réglage rouge

La poignée rouge est
déplacée vers la
droite

Notez que les points
In et Out restent
stationnaires.
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Les trois poignées de réglage du volume peuvent être utilisées pour augmenter ou
diminuer le volume d’un événement. Pour afficher les poignées de réglage du volume
d’un événement, cliquez sur l’événement souhaité de sorte qu’il se place en surbrillance.
Cliquez et faites glisser la poignée souhaitée.

Avant :

   

Après :

       

$
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Pour apporter un réglage fin au volume, maintenez la touche Ctrl enfoncée tandis que
vous cliquez-déplacez la poignée.

7-8 Fades et Crossfades
Création de Fades :
Pour créer un fondu entrant (Fade-In), utilisez l’outil de sélection pour sélectionner un
point In à gauche de l’événement et un point Out à l’intérieur de l’événement.

Avant :

La poignée gauche de réglage du
volume est déplacée vers le bas.
Notez la modification de la forme
d’onde reflétant la baisse de volume.

La poignée centrale de réglage du
volume est déplacée vers le bas.
Notez la modification de la forme
d’onde reflétant la baisse de volume.

La poignée droite de réglage du
volume est déplacée vers le bas.
Notez la modification de la forme
d’onde reflétant la baisse de volume.

L’événement est
sélectionné

Région audio
sélectionnée pour
le Fade-In
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Cette zone est placée en surbrillance. La durée de la sélection détermine la durée du Fade.
Cliquez sur le bouton Fade de la barre d’édition ou utilisez le raccourci clavier
correspondant.

Après :

Procédez de la même manière pour réaliser un fondu sortant (Fade-Out), mais placez le
point In à l’intérieur de l’événement et le point Out à droite de l’événement.

 5
&

Fade : Ctrl + F sous Microsoft Windows, Cmd + F sur Macintosh

Création de Crossfades :
Pour créer un Crossfade, utilisez l’outil de sélection pour sélectionner un point In à
l’intérieur de l’événement de gauche et un point Out à l’intérieur de l’événement de
droite. La zone est placée en surbrillance. Cliquez sur le bouton Fade ou utilisez le
raccourci clavier correspondant pour créer le Crossfade.

Avant :

Après :

Le Fade-In est exécuté.
Notez que la forme
d’onde reflète à présent
la variation de volume
due au Fade-In.

Zone située entre les
deux événements
sélectionnés pour le
Crossfade.

Le Crossfade
commence au
point In et se
termine au point
Out.
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Vous pouvez aussi créer un Crossfade en faisant glisser un événement avec Fade-Out
vers un événement avec Fade-In. Cliquez simplement sur l’événement de gauche avec
l’outil Drag and Trim, puis faites-le glisser vers l’événement suivant.

Avant :

Après :

Réglage de la durée des Fades
Vous pouvez régler la durée des Fades à l’aide des poignées correspondantes. Pour
accéder à ces poignées, cliquez une fois sur l’événement souhaité à l’aide de l’outil Drag
and Trim. Déplacez la souris sur la poignée de Fade souhaitée de sorte que le curseur se
transforme en une double-flèche. Cliquez-déplacez la poignée pour régler la durée du
Fade.

Avant :

Après :

7-9 Presse-papiers multiples
Sur MX-View, vous pouvez sauvegarder des données dans un maximum de quatre
presse-papiers indépendants et sélectionnables depuis la barre d’édition.

Sauvegarde de données dans le presse-papier :

L’événement est
sélectionné et la
poignée de Fade droite
est déplacée vers la
droite.

Le Fade-Out est étendu.

L’événement
sélectionné est
déplacé vers la
droite à l’aide de
l’outil Drag and
Trim.

Le Fade-Out de
l’événement de
gauche et le Fade-In
de l’événement de
droite se
chevauchent, créant
un Crossfade.
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Cliquez sur le presse-papier de destination de façon à le sélectionner. Sélectionnez une
région ou un événement audio, puis choisissez une commande d’édition qui placera les
données sélectionnées dans le presse-papier (commande Couper, Copier ou Supprimer).
Vous pouvez ensuite sélectionner un autre numéro de presse-papier et exécuter une autre
commande de Couper, Copier ou Supprimer.

Utilisation du contenu du presse-papier :
Sélectionnez d’abord le presse-papier souhaité. Choisissez alors une commande de type
Coller ou Insérer pour placer le contenu du presse-papier dans la fenêtre principale de
MX-View. Vous pouvez ensuite sélectionner un autre presse-papier et exécuter une autre
commande de type Coller ou Insérer.

Tous les presse-papiers conservent leurs données d’un projet à l’autre. Cependant, ces
données sont supprimées lorsque le MX-2424 est placé hors tension ou lorsque vous
exécutez la commande de démontage (Unmount) ou de nettoyage (Disk Cleanup) du
disque dur.

� Note : Si aucun presse-papier n’est sélectionné, les données sont placées par défaut dans le presse-
papier n° 1 (presse-papier par défaut).

7-10 Glissement des données d’un événement
Cette fonction permet de faire glisser les données audio vers la gauche ou vers la droite
sans déplacer les points In et Out. Pour exécuter cette fonction, sélectionnez un
événement, maintenez la touche A enfoncée et cliquez-déplacez l’événement sélectionné.
Notez que vous devez utiliser l’outil Drag and Trim pour cette fonction.

Avant :

Après :

Evénement sélectionné

Faites alors glisser
l’événement vers la
droite en maintenant la
touche A enfoncée, en
cliquant sur l’événement
et en le faisant glisser
vers la droite.

Notez que la position
des points In  et Out
reste identique
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Cette fonction conserve la position des points In et Out tout en faisant glisser les données
audio vers la gauche ou la droite à l’intérieur de l’événement sélectionné. Les données
audio situées hors des points In et Out ne sont pas modifiées.  

7-11 Fonction Compile
La fonction Compile crée une piste virtuelle “compilée” à partir d’événements audio
sélectionnés parmi des pistes virtuelles sélectionnées. En maintenant la touche Shift
enfoncée, sélectionnez des événements individuels à l’aide de l’outil Drag and Trim.
Notez que vous pouvez uniquement sélectionner des événements situés dans un groupe
de pistes virtuelles.

Dans le menu Edit, sélectionnez la fonction Compile. Saisissez un nouveau nom pour la
piste compilée à créer.
Une nouvelle piste virtuelle comprenant les événements compilés est alors créée.

� Note : Plus les événements sont situés vers le haut, plus ils sont prioritaires en cas de
chevauchement des événements lors de la compilation.

Evénements
sélectionnés pour la
compilation.

Piste compilée
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Chapitre 8 : Utilisation avancée

Le Chapitre 8 traite de manière approfondie des groupes, des marqueurs de localisation, des afficheurs de
niveau, ainsi que de l’automation du volume et des Mutes.

8-1 Utilisation des groupes ( N/C)
Cette fonction sera disponible dans une mise à jour ultérieure.

8-2 Utilisation des marqueurs de localisation
Note : La fenêtre des marqueurs de localisation sera disponible sur une mise à jour
ultérieure. Cette fenêtre permettra de nommer, supprimer et déplacer les marqueurs de
localisation. Pour l’instant, vous pouvez utiliser les raccourcis clavier suivants :

5
&

Créer un nouveau marqueur :
Touche Return sous Microsoft Windows et sur Macintosh

5
&

Créer des marqueurs spécifiques :
La touche C suivie de deux chiffres spécifiant un emplacement mémoire particulier sous
Microsoft Windows et sur Macintosh

5
&

Localisation d’un marqueur spécifique :
La touche V suivie de deux chiffres spécifiant un emplacement mémoire particulier sous
Microsoft Windows et sur Macintosh

8-3 Afficheurs de niveau
La fenêtre Meters présente 24 afficheurs indiquant l’amplitude de niveau du signal audio,
comme en façade du MX-2424.

Dans le menu File de la fenêtre Meters, vous pouvez configurer la hauteur et la largeur de
la fenêtre Meters.

Notez qu’avec des fréquences d’échantillonnage x 2 (88,1 - 96 kHz), il ne s’affiche que
12 afficheurs de niveau par MX-2424.

Présence de signal
(-60 dB)

Niveau d’écrêtage
du signal (0 dB)Mémorisation

de crêtes

Niveau du
signal
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8-4 Automation du volume par points d’édition
L’automation du volume par points d’édition permet de créer et de déplacer des points
d’édition pour faire varier le volume d’une piste. Chaque piste individuelle dispose de ses
propres données d’automation du volume. Le principe est similaire à celui des systèmes
d’automation des Faders que l’on peut trouver sur les consoles de mixage.

Création de points d’automation :
Pour commencer une automation du volume, cliquez sur le bouton d’automation du

volume ( ) de la barre d’édition, puis sélectionnez l’outil Drag and Trim. Pour créer un
point d’automation, cliquez dans la piste souhaitée puis faites glisser le point sur le
niveau souhaité. Un petit cadre comprenant la valeur du gain (ainsi que la variation du
gain entre parenthèses) apparaît à l’écran pour vous aider à trouver le niveau souhaité de
manière précise. Pour ajuster un point d’édition existant, cliquez sur ce point de sorte
qu’il s’affiche en blanc, puis faites-le glisser verticalement ou horizontalement sur la
piste. Pour apporter un réglage plus fin à un point d’édition existant, effectuez une édition
par cliquer-déplacer.

Edition des points d’automation :
Lorsque les données d’automation d’un point d’édition sont affichées, l’édition des
données audio est verrouillée. Seules les données des points d’automation peuvent être
modifiées. Cependant, les données d’automation peuvent également être éditées (copier,
coller, supprimer, etc.) lorsque vous utilisez l’outil de sélection. Utilisez l’outil de
sélection pour sélectionner les données d’automation à éditer. La région apparaît en
surbrillance et les points d’automation s’affichent en blanc. Vous pouvez à présent
effectuer les éditions souhaitées (Nudge, copier, coller, etc.). Pour supprimer des points
d’automation, sélectionnez-les puis appuyez sur la touche Delete/Backspace.

Avant :

Point
d’automation
sélectionné pour
l’édition.

Données
d’automation
comprenant la
valeur du gain,
ainsi que la
variation de gain
du point
sélectionné.

Région
sélectionnée
et copiée dans
le presse-
papier.
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Après :

$
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Vous pouvez copier et coller les données d’automation en aval d’un morceau ou d’une
piste à l’autre lorsque vous utilisez l’outil de sélection. Ainsi, il est facile d’affecter la
même automation du volume à un refrain ou un couplet !

5
&

Autres raccourcis clavier pratiques pour l’automation du volume par points d’édition :
Shift-Cliquer : Sélection de points d’automation supplémentaires
Alt-Cliquer & Déplacer : Copie de points d’automation
Shift-Cliquer & Déplacer : Conserver le gain ou la position temporelle durant la
modification de la durée ou la copie.

8-5 Automation des Mutes
L’automation des Mutes vous permet de couper ou non chaque piste individuelle,
pratiquement comme les boutons Mute d’une console de mixage automatisée. Pour
utiliser l’automation des Mutes, cliquez d’abord sur le bouton d’automation des Mutes

( ) situé dans la barre d’édition, puis sélectionnez l’outil Drag and Trim. Un point
d’automation de Mute peut se trouver en haut (piste non coupée) ou en bas (piste
coupée). Pour créer un point de Mute, cliquez dans la piste souhaitée et faites glisser le
point vers le haut ou vers le bas de la piste. Vous pouvez aussi faire glisser le point
d’automation de Mute vers la gauche ou vers la droite.

Les règles d’édition des données d’automation décrites plus haut dans la section 8-4,
Automation du volume, s’appliquent également à l’automation des Mutes.

5
&

Les raccourcis clavier suivants simplifient la sélection de l’édition des formes d’ondes, de
l’automation du volume ou de l’automation des Mutes.

F8 : Edition des événements
F9 : Edition de l’automation du volume

F10 : Edition de l’automation des Mutes

La commande
Coller (Paste)
place les données
d’automation du
presse-papier sur
le point In

La piste n’est pas
coupée.

La piste est coupée.
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Chapitre 9 : Projets et utilitaires

Le Chapitre 9 traite de la gestion des projets et du disque, du chargement et de la Smart Copy des projets à
la sauvegarde/restauration par Ethernet. Vous y trouverez également toutes les informations concernant les
préférences et les utilitaires du disque, dont les fonctions de nettoyage du disque, d’initialisation, de
formatage de bas niveau, et plus encore.

9-1 Chargement des projets
La fenêtre Project/Track affiche tous les disques, projets et pistes disponibles sur chaque
MX-2424 ou MMR/MMP en réseau. Les flèches de menu permettant d’afficher ou de
masquer les éléments contenus. Pour charger un projet, accédez à la fenêtre Project/Track
et cliquez sur le menu de l’appareil souhaité de sorte que tous les disques connectés
s’affichent. Cliquez sur la flèche de menu du disque (SCSI ID) pour afficher tous les
projets existants sur ce disque. Pour charger un projet, double-cliquez sur le nom ou
l’icône du projet souhaité. Notez qu’un seul clic sur la flèche de menu d’un projet permet
d’afficher toutes les pistes qu’il contient.

9-2 Utilitaires des projets
Pour exécuter un utilitaire de projet, comme la fonction Smart Copy, Rename ou la
conversion TapeMode, un projet doit être sélectionné dans la fenêtre Project/Track.
Notez que la progression de l’opération et un bouton d’annulation se trouvent en bas de la
fenêtre Project/Track.

Fonction Smart Copy :
Pour effectuer une Smart Copy, sélectionnez le projet souhaité, puis sélectionnez la
fenêtre Project/Track → Menu File → Smart Copy. Une fenêtre apparaît, permettant
de renommer le projet (champ Project name) et de choisir le disque de destination (menu
déroulant Destination device) (identifiant du disque SCSI).

$
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Il est également possible d’effectuer la Smart Copy d’un projet en sélectionnant le projet
 dans la fenêtre Project/Track, puis en le faisant glisser sur un autre disque.

Menu déroulant de
l’enregistreur

Menu déroulant du
disque

Menu déroulant
d’un projet

Pistes
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Lorsque vous avez lancé une procédure de Smart Copy, la progression est indiquée sous
forme de pourcentage en bas de la fenêtre Project/Track. Lorsque la tâche est terminée,
un message apparaît et une marque (v) apparaît en face de l’opération. Notez que lorsque
vous cliquez sur l’opération réalisée, elle disparaît de la liste.

Fonction Tape Mode Convert :
Pour appliquer la fonction Tape Mode Convert, sélectionnez le projet souhaité, puis
sélectionnez Fenêtre Project/Track →Menu File → Tape Mode Convert. Une fenêtre
apparaît, vous invitant à choisir le disque de destination (identifiant du disque SCSI).

Comme avec la fonction Smart Copy, la progression s’affiche sous forme de pourcentage
en bas de la fenêtre et vous disposez également d’un bouton d’annulation de l’opération.
Si vous appuyez sur ce bouton d’annulation, une invite vous demande de confirmer
l’opération avant de continuer.

Cliquez sur cette marque
pour supprimer le message
de la fenêtre.

Bouton
d’annulation
de l’opération

Opération en
cours

Progression en
pourcentage réalisé
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Renommer un projet :
Pour renommer un projet, sélectionnez le projet souhaité, puis sélectionnez Fenêtre
Project/Track → Menu File → Rename Project. Une fenêtre apparaît, permettant de
renommer le projet. Saisissez le nom souhaité dans le champ Project name, puis cliquez
sur Rename pour confirmer ou Cancel pour quitter sans exécuter l’opération.

Supprimer un projet/une piste :
Pour supprimer un projet, sélectionnez la piste ou le projet souhaité, puis sélectionnez
Fenêtre Project/Track → Menu File → Delete Project. Cliquez sur Delete pour
confirmer ou sur Cancel pour annuler l’opération.

9-3 Sauvegarde et restauration en réseau
Sauvegarde en réseau :
MX-View vous permet de sauvegarder votre projet par Ethernet sur l’ordinateur hôte. Les
sauvegardes sont réalisées au format BU (TimeLine BackUp), ce qui vous permet de
segmenter un projet pour l’adapter à différents supports de sauvegarde. Une fois sur
l’ordinateur hôte, les segments BU peuvent aisément être sauvegardés sur CD-R,
CD-RW, DVD-R ou autre support de sauvegarde. Ainsi, par exemple, un projet de 4 Go
sur le disque dur de l’enregistreur peut être sauvegardé sur quelques CD seulement grâce
à votre ordinateur. Avant d’effectuer une sauvegarde en réseau, sélectionnez le format
souhaité dans Menu File → Net Backup Format (dans la fenêtre Project/Track).

Notez que vous pouvez aussi personnaliser la taille de chaque segment en choisissant
l’option Manual.
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Lorsque vous avez choisi un format, sélectionnez la fonction Network Backup du menu
File. Une fenêtre vous permet alors de choisir la destination et le nom de la sauvegarde.
Cliquez sur le bouton Save pour lancer la procédure. Un compteur de progression
apparaît alors en bas de la fenêtre Project/Track.

Restauration en réseau :
Pour récupérer un projet se trouvant sur votre ordinateur hôte, sélectionnez Menu File →
Network Restore (dans la fenêtre Project/Track). Localisez et sélectionnez le dernier
fichier de sauvegarde du groupe souhaité. Par exemple, lorsque vous récupérez un projet
de 3 segments : MXProject.bu, MXProject_2.bu et MXProject_3.bu, sélectionnez
d’abord le segment MXProject_3.bu.

Après avoir sélectionné le fichier BU, cliquez sur Open. Une fenêtre vous demande alors
de saisir le nom du projet et de choisir le disque SCSI de destination de la restauration.

Cliquez sur OK pour lancer l’opération. Un compteur de progression apparaît en bas de la
fenêtre Project/Track. Lorsque la restauration est terminée, un message confirme que
l’opération s’est correctement déroulée.
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9-4 Utilitaires de disque dur
Pour utiliser un utilitaire du disque autre que la fonction de nettoyage Disk Cleanup, tous
les volumes doivent être démontés. Pour démonter ou monter un volume, sélectionnez
respectivement Fenêtre Project/Track → Menu Volumes → Unmount ou Mount .
Pour plus d’informations sur les fonctions Mount/Unmount, consultez la page 19 du
mode d’emploi complet du MX-2424.

Nettoyage du disque dur :
Pour nettoyer le disque dur, vérifier que tous les disques sont montés et sélectionnez
Fenêtre Project/Track → Menu Volumes → Disk Cleanup. A la fin de la procédure,
un message confirme que l’opération s’est correctement déroulée. Pour plus
d’informations sur cette fonction, consultez la page 46 du didacticiel du MX-2424.

Initialisation :
Pour initialiser un volume, vérifiez que tous les disques sont démontés et sélectionnez
Fenêtre Project/Track → Menu Volumes → Initialize . La fenêtre qui apparaît vous
demande de sélectionner l’identifiant du disque SCSI et le format (HFS, HFS+ ou
FAT32). Lorsque l’initialisation est terminée, un message vient confirmer le bon
déroulement de l’opération.

Pour plus d’informations sur l’initialisation du disque, consultez la page 48 du didacticiel
du MX-2424.

� Note : Si l’identifiant du disque SCSI n’apparaît pas dans le menu déroulant Device, sélectionnez
l’option Other du menu déroulant. Ensuite, saisissez l’identifiant du disque SCSI dans le champ
Device.

Formatage de bas niveau :
Pour appliquer un formatage de bas niveau à un volume, vérifiez que tous les disques
sont démontés et sélectionnez Fenêtre Project/Track → Menu Volumes → Low Level
Format. Une fenêtre apparaît, vous demandant de sélectionner l’identifiant du disque
SCSI. Appuyez sur Format pour continuer. Lorsque l’opération est terminée, un message
confirme que le formatage a été correctement effectué. Pour plus d’informations sur le
formatage de bas niveau, consultez la page 47 du didacticiel du MX-2424.

Menu déroulant de
sélection de
l’identifiant du
disque SCSI

Champ de saisie
de l’identifiant du
disque SCSI
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Supprimer les données sauvegardées :
Pour supprimer les données sauvegardées sur un volume, vérifiez que tous les disques
sont démontés et sélectionnez Fenêtre Project/Track → Menu Volumes → Backup
Erase. Une fenêtre vous demande alors de sélectionner l’identifiant du disque SCSI.
Notez que l’opération Backup Erase peut uniquement être appliquée à un support
DVD-RAM ou Travan. A la fin de la procédure, un message confirme que le formatage
s’est correctement déroulé.

Pour plus d’informations sur la fonction Backup Erase, consultez la page 44 du mode
d’emploi complet du MX-2424.

9-5 Mise à jour logicielle (MX-2424)
Il est possible d’effectuer une mise à jour logicielle via le menu Machines situé dans la
fenêtre Network.

Lorsque vous sélectionnez la fonction Update Software, une fenêtre vous demande de
sélectionner la DXIMAGE ou image logicielle à transmettre à la carte TL Media (carte
Smart Media). Cliquez sur Open pour lancer la mise à jour logicielle.
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A la fin de la mise à jour, une fenêtre vous demande de laisser la carte dans le MX-2424
et de redémarrer l’appareil. Au redémarrage, la carte TL Media remet à jour le logiciel du
MX-2424. Retirez la carte TL Media et redémarrez encore le MX-2424. La mise à jour
est terminée et le MX-2424 est prêt à être utilisé.

9-6 Préférences ( N/C)
Cette fonctionnalité sera disponible dans une mise à jour ultérieure.

$
VWXFH

Suppression des préférences sur les ordinateurs sous Microsoft Windows : MX-View
sauvegarde plusieurs préférences utilisateur, comme la taille et la position des fenêtres,
etc. Ces préférences permettent à l’utilisateur de retrouver la configuration des fenêtres
telle qu’elle était lors de la fermeture de l’application. Pour supprimer ces préférences et
retrouver l’état initial de MX-View, il suffit de lancer l’application nommée “Clear
MX-View Preferences” du groupe de programmes MX-View. Vous pouvez accéder au
groupe de programmes MX-View depuis le bouton Démarrer de Windows.
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Chapitre 10 : Pistes
Le Chapitre 10 traite de manière approfondie de la gestion des pistes (chargement, déchargement,
suppression, renommer, utilisation des pistes virtuelles). Pour accéder aux définitions des pistes chargées, non
chargées et virtuelles, consultez la section 4-6 et la page 35 du didacticiel du MX-2424 (Pistes virtuelles).

10-1 Menu des pistes
Pour utiliser les fonctions applicables aux pistes, vous devez d’abord appuyer sur le
bouton de menu des pistes pour afficher le menu déroulant correspondant. Ce menu est
disponible pour toutes les pistes virtuelles ou chargées.   

Ce menu présente les options suivantes : création d’une nouvelle piste virtuelle (New
Virtual Track), chargement d’une piste (Load Track), déchargement d’une piste (Unload
Track), renommer une piste (Rename Track) et supprimer une piste (Delete Track).

10-2 Création d’une nouvelle piste virtuelle
Accédez au menu déroulant d’une piste et sélectionnez l’option New Virtual Track. La
fenêtre illustrée ci-dessous vous propose d’affecter un nom à la nouvelle piste virtuelle
(champ Name). Le nom par défaut comprend le nom de la piste existante, suivi du
numéro de la prise. Cliquez sur le bouton OK pour créer la nouvelle piste virtuelle.

La nouvelle piste virtuelle apparaît au-dessus de la piste d’origine.

Activer les pistes virtuelles
Pour activer/désactiver une piste virtuelle, il suffit de cliquer une fois sur le bouton Activation/
Désactivation de la piste, de sorte qu’il se place en surbrillance. Vous pouvez masquer toutes
les pistes virtuelles en cliquant sur le bouton Masquer/Afficher des pistes virtuelles.

Bouton de menu
des pistes

Menu
déroulant des
pistes

Bouton de la piste virtuelle
désactivé. Cette piste ne peut ni
lire ni enregistrer des données
audio. Vous pouvez toutefois
éditer cette piste.

Bouton activé. Cette piste
virtuelle peut lire ou enregistrer
des données audio.

Masquer/Afficher les
pistes virtuelles

Poignées de déplacement
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Déplacer les pistes virtuelles
Vous pouvez déplacer les pistes virtuelles inactives vers le haut ou vers le bas à l’aide des
poignées de déplacement. Une ligne blanche vous guide alors dans le déplacement de la
piste virtuelle inactive souhaitée.

10-3 Charger une piste
Sélectionnez l’option Load Track dans le menu déroulant des pistes. Cela ouvre la fenêtre
Project/Track et vous permet de choisir la piste à charger. Vous pouvez choisir de charger
une piste du projet en cours ou d’autres projets. Une fois la piste à charger sélectionnée,
vous pouvez la placer sur la piste de destination souhaitée à l’aide du menu déroulant
Destination track. Notez que les projets à doubles fréquences d’échantillonnage
(88,2 - 96 kHz) fonctionnent uniquement en mode 12 pistes ; vous ne pouvez alors
choisir une piste de destination que parmi les pistes 1 à 12.

10-4 Décharger une piste
Sélectionnez l’option Unload Track dans le menu déroulant de la piste. Une fenêtre
apparaît, vous permettant d’annuler l’opération ou de poursuivre le déchargement des
pistes.

10-5 Renommer une piste
Sélectionnez l’option Rename Track dans le menu déroulant de la piste. Une fenêtre
apparaît, permettant de renommer la piste. Saisissez le nom de piste souhaité, puis cliquez
sur OK pour confirmer le nouveau nom ou sur Cancel pour annuler l’opération.

10-6 Supprimer une piste
Sélectionnez l’option Delete Track dans le menu déroulant de la piste. Cliquez sur Delete
pour confirmer la suppression de la piste ou sur Cancel pour annuler l’opération.

Menu déroulant de
sélection de la
piste de destination

Ligne blanche
servant de guide
pour le
déplacement des
pistes

Piste virtuelle active

Pistes inactives
virtuelles
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Chapitre 11 : Utilisation de plusieurs enregistreurs

Il est possible de visualiser plusieurs enregistreurs dans la fenêtre principale de MX-View. Ce chapitre
traite de l’utilisation de plusieurs enregistreurs avec MX-View.

11-1 Connexion à plusieurs enregistreurs
Chargement des enregistreurs dans la fenêtre principale de MX-View :
MX-View détecte automatiquement tous les enregistreurs connectées au réseau local et
les place automatiquement dans la fenêtre Network. Dans la fenêtre Network,
sélectionnez les enregistreurs souhaités (local et distant) tout en maintenant enfoncée la
touche Ctrl sous Microsoft Windows ou la touche Cmd sur Macintosh, de sorte qu’ils
s’affichent en surbrillance. Ensuite, sélectionnez Menu File → Edit ou appuyez sur la
barre d’espace. Les enregistreurs apparaissent à présent l’un après l’autre dans la fenêtre
principale de MX-View. L’ordre d’affichage des enregistreurs dans la fenêtre principale
dépend de leur ordre de sélection dans la fenêtre Network. Chaque enregistreur est séparé
du précédent par sa propre règle temporelle et peut être utilisé indépendamment des
autres appareils reliés au réseau, bien que cette fonction soit plus optimisée avec les
appareils synchronisés via le Bus TL.

Lorsque plusieurs appareils sont lancés dans la fenêtre principale de MX-View, une
colonne supplémentaire pour les numéros d’identifiant (ID) des appareils (Bus) est
ajoutée à droite des principales commandes de transport. La fenêtre de transport et le
clavier peuvent uniquement contrôler l’appareil dont l’identifiant est en surbrillance. Pour
pouvoir contrôler un autre appareil à l’aide de la fenêtre de transport et du clavier, cliquez
une fois sur l’identifiant de l’appareil souhaité.

Identifiant de l’appareil (Bus ID). Dans cette
illustration, la fenêtre de transport et le clavier
contrôlent l’appareil relié au Bus 2.

Pistes de
l’enregistreur 1

Pistes de
l’enregistreur 2

Règle
temporelle de
l’enregistreur 1

Règle
temporelle de
l’enregistreur 2
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Lorsque plusieurs enregistreurs sont connectés, le segment Transport focus (cible des
commandes de transport) est ajouté à la barre Machine Info.

Connexion à des appareils distants :
Dans certaines situations, vous pouvez être amené à connecter un appareil ne se trouvant
pas sur le réseau local. Par exemple, un utilisateur de MX-View à New York souhaite se
connecter à un MX-2424 se trouvant dans un studio de Los Angeles. Grâce à la fonction
New Remote Machine, cela est possible. Pour relier un appareil distant à la fenêtre
Network, ouvrez la fenêtre Network et sélectionnez Menu Machine → New Remote
Machine. Saisissez le nom et l’adresse IP de l’appareil distant.

L’appareil distant apparaît alors dans la liste principale de la fenêtre Network, avec
l’icône d’un globe placée à gauche signalant qu’il s’agit d’un appareil distant.

11-2 Configuration de studio
La fenêtre Network propose un système efficace de gestion de plusieurs studios et de
plusieurs appareils.

Création d’un nouveau studio :
Sélectionnez l’option New Studio dans le menu Machines (fenêtre Network).

Saisissez le nom du nouveau studio. Chaque studio apparaît sous forme d’un dossier.
Pour placer des appareils dans un studio, faites glisser l’icône de l’appareil dans le
dossier de studio souhaité. Dans l’exemple suivant, la fenêtre Network affiche trois
studios : Studio A, Studio B et Studio C. Le Studio B dispose d’un enregistreur 24 pistes
distant.

Barre Machine InfoSegment Transport
focus
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Les enregistreurs peuvent être déplacés d’un studio à l’autre, renommés ou supprimés
grâce au menu Machines de la fenêtre Network. Ce menu permet également de renommer
et de supprimer les studios.

11-3 Plusieurs enregistreurs en cours d’utilisation
Pour que tous les enregistreurs fonctionnent simultanément dans la fenêtre principale de
MX-View, ils doivent être synchronisés sur le Bus TL (Bus MMR pour les MMR/MMP).
Vérifiez que tous les appareils sont en ligne (bouton Online) et que le Bus maître est bien
sélectionné comme cible des commandes de transport (voir segment Transport focus,
section 11-1). Chaque appareil dispose d’un bouton Online situé à gauche de son
compteur temporel, ce qui permet une identification rapide des appareils en ligne.

A gauche du bouton Online se trouve un menu déroulant. Ce dernier existe uniquement
lorsque plusieurs enregistreurs sont affichés dans une fenêtre principale de MX-View. Ce
menu déroulant vous permet d’accéder aux réglages des appareils, d’ouvrir la fenêtre des
afficheurs de niveau, de créer un nouveau projet, d’accéder à la fenêtre Project/Track et,
dans une mise à jour ultérieure, d’importer et d’exporter des fichiers audio.

L’édition sur plusieurs enregistreurs dans la fenêtre principale de MX-View est similaire
à l’édition sur un seul enregistreur. Toutefois, les données audio sélectionnées sur un
multipiste ne peuvent pas être placées sur les pistes audio d’un autre multipiste.

Bouton Online
Menu déroulant
de l’appareil
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Annexe A : Raccourcis clavier

Projet Macintosh Windows
Nouveau projet Cmd + N Ctrl + N
Charger projet/piste (ouvrir la
fenêtre Project/Track)

Cmd + O Ctrl + O

Fermer fenêtre Cmd + W Ctrl + W
Quitter Cmd + Q Ctrl + Q

Fenêtres (Afficher/Masquer) Macintosh Windows
Transport Cmd + 1 Ctrl + 1
Réglages Cmd + 2 Ctrl + 2
Vue générale Cmd + 3 Ctrl + 3
Afficheurs de niveau Cmd + 4 Ctrl + 4
Marqueurs de localisation Cmd + 5 Ctrl + 5
Groupes Cmd + 6 Ctrl + 6
Project/Track (chargement et
utilitaires)

Cmd + 7 ou Cmd + O Ctrl + 7

Importer/Exporter Audio Cmd + 8 Ctrl + 8
Edition (fenêtre principale MX-View) Cmd + 9 Ctrl + 9
Réseau Cmd + 0 ou Cmd + Shift + N Ctrl + 0 ou Ctrl + Shift + N

Edition Macintosh Windows
Annuler Cmd + Z Ctrl + Z
Rétablir Cmd + Y Ctrl + Y
Couper Cmd + X Ctrl + X
Copier Cmd + C Ctrl + C
Coller Cmd + V Ctrl + V
Supprimer Cmd + B ou Delete/Backspace Ctrl + B ou Delete/Backspace
Insérer Cmd + I Ctrl + I
Ouvrir Cmd + H Ctrl + H
Sélectionner tous les événements dans Cmd + A Ctrl + A
Sélectionner d’autres événements
vers gauche/droite

Shift + Õ/Ö Shift + Õ/Ö

Diviser Cmd + E Ctrl + E
Séparer Cmd + U Ctrl + U
Dupliquer Cmd + D Ctrl + D
Isoler Cmd + T Ctrl + T
Nudge - / + (ou =) - / + (ou =)
Fade Cmd + F Ctrl + F
Fade to start Opt + D Alt + D
Fade to end Opt + G Alt + G
Répéter Cmd + R Ctrl + R
Sync Insert Cmd + Shift + I Ctrl + Shift + I
Sync Paste Cmd + Shift + V Ctrl + Shift + V
Coller à gauche Cmd + Shift + L Ctrl + Shift + L
Coller sur tête de lecture Cmd + Shift + P Ctrl + Shift + P
Point In sur tête de lecture (In to Now) Cmd + M Ctrl + M
Couper à gauche Cmd + Shift + X Ctrl + Shift + X
Coupe locale Cmd + Shift + S Ctrl + Shift + S
Coupe locale à gauche Cmd + Shift + D Ctrl + Shift + D
Fusion des événements Cmd + Shift + R Ctrl + Shift + R
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Transport et Locator Macintosh Windows
Play/Stop Barre d’espace Barre d’espace
Ramener vue sur tête de lecture Cmd + P Ctrl + P
Enregistrer Cmd + Barre d’espace Ctrl + Barre d’espace
Lecture du point In à Out Shift + Barre d’espace Shift + Barre d’espace
Online/Offline Cmd + J Ctrl + J
Online/Offline tous appareils Cmd + Alt + J Ctrl + Alt + J
Capture In Cmd + × Ctrl + ×
Capture Out Cmd + Ø Ctrl + Ø
Capture nouveau marqueur de
localisation

Enter (incréments automatiques) Enter (incréments automatiques)

Capture C suivi des deux chiffres du
point en mémoire, ou de I pour
In et O pour Out

C  suivi des deux chiffres du
point en mémoire, ou de I pour
In et O pour Out

Placer sur marqueur V  suivi des deux chiffres du
point en mémoire, ou de I pour
In et O pour Out

V  suivi des deux chiffres du
point en mémoire, ou de I pour
In et O pour Out

Placer tête de lecture sur marqueur
précédent/suivant

Cmd + Õ/Ö Ctrl + Õ/Ö

Placer tête de lecture sur édition
précédente/suivante

Shift + Tab / Tab
(précédent/suivant)

Shift + Tab / Tab
(précédent/suivant)

Point In I (localisation lorsqu’utilisé seul,
ou cible après F,T,Y,C,V)

I (localisation lorsqu’utilisé seul,
ou cible après F,T,Y,C,V)

Point Out O (localisation lorsqu’utilisé
seul, ou cible après F,T,Y,C,V)

O (localisation lorsqu’utilisé
seul, ou cible après F,T,Y,C,V)

Destination (To) T suivi de I ou O T suivi de I ou O
Provenance (From) F suivi de I ou O F suivi de I ou O
Passant par (Thru) Y suivi de I ou O Y suivi de I ou O
Lecture à partir du dernier point de
lancement

L L

Roll avant/arrière , / . , / .
Avance rapide Cmd + . (point) Ctrl + . (point)
Retour rapide Cmd + , (virgule) Ctrl + , (virgule)

Valeurs des compteurs Macintosh Windows
Passer sur compteur suivant ` (guillemet fermant) ` (guillemet fermant)
Incrément / décrément × / Ø × / Ø
Sélection des heures, minutes,
secondes, images, sous-images

Õ, Ö Õ, Ö

Annuler saisie Escape Escape
Confirmer la saisie Enter Enter

Options des boutons de pistes Macintosh Windows
Changer statut d’un paramètre et régler
tous les autres sur le même statut
(armement en enregistrement, vue
automation du volume, édition, etc.)

Alt Alt

Changer statut d’un paramètre et régler
tous les autres sur le statut opposé

Ctrl Ctrl



87

Sélection Macintosh Windows
Outil de sélection F1 F1
Outil Main F2 F2
Outil Zoom F3 F3
Outil de Scrubbing F4 F4
Sélection temporaire de l’outil de
gauche

F6 F6

Sélection temporaire de l’outil de
droite

F7 F7

Edition Evénements audio F8 F8
Edition Automation du volume F9 F9
Edition Automation des Mutes F10 Non disponible

Modes de lecture Macintosh Windows
Automatique (enregistr./répétition) Cmd + Shift + A Ctrl + Shift + A
Avec Pré/Post-Roll Cmd + K Ctrl + K
En boucle Cmd + L Ctrl + L

Options de l’outils de sélection Macintosh Windows
Localisation Cliquer Cliquer
Sélection In, Out, pistes à éditer Cliquer + Déplacer Cliquer + Déplacer
Ajouter piste à éditer Shift + Cliquer Shift + Cliquer
Etendre In, Out, pistes à éditer Shift + Cliquer + Déplacer Shift + Cliquer + Déplacer
Désélectionner une piste à éditer Shift + Cliquer sur piste sélectionnée

Ou
Ctrl + Cliquer sur piste sélectionnée

Shift + Cliquer sur piste sélectionnée
Ou
Ctrl + Cliquer sur piste sélectionnée

Supprimer région d’une sélection
In, Out, pistes à éditer

Ctrl + Cliquer + Déplacer Ctrl + Cliquer + Déplacer

Annuler sélection par glissement Esc Esc
Passer temporairement à l’outil
Drag and Trim

F6 F6

Passer temporairement à l’outil Zoom F7 F7

Options de l’outil Drag and Trim Macintosh Windows
Sélectionner événement Cliquer Cliquer
Ajouter événement à la sélection Shift + Cliquer sur événement

non sélectionné
Shift + Cliquer sur événement
non sélectionné

Désélectionner événement Shift + Cliquer sur événement
sélectionné
Ou
Ctrl + Cliquer sur événement
sélectionné

Shift + Cliquer sur événement
sélectionné
Ou
Ctrl + Cliquer sur événement
sélectionné

Déplacer Cliquer + Déplacer Cliquer + Déplacer
Déplacer événement sans variation
temporelle horizontale

Ctrl Ctrl

Copier au lieu de déplacer Alt Alt
Renommer événement Double-cliquer sur événement Double-cliquer sur événement
Glisser les données audio dans
l’événement

A + Cliquer + Déplacer
événement sélectionné

A + Cliquer + Déplacer
événement sélectionné

Sélectionner événements de la
région

Cliquer + Déplacer depuis zone
vide

Cliquer + Déplacer depuis zone
vide

Sélectionner événements
supplémentaires dans la région

Shift + Cliquer + Déplacer
depuis zone vide

Shift + Cliquer + Déplacer
depuis zone vide
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Options de l’outil Drag and Trim Macintosh Windows
Désélectionner événements dans la
région

Ctrl + Cliquer + Déplacer depuis
zone vide

Ctrl + Cliquer + Déplacer depuis
zone vide

Forcer la sélection d’une région
spécifique

R + Cliquer + Déplacer
événement, fonctionne aussi
avec Shift (ajouter) ou Ctrl
(supprimer)

R + Cliquer + Déplacer
événement, fonctionne aussi
avec Shift (ajouter) ou Ctrl
(supprimer)

Annuler sélection par déplacement,
déplacement d’événement ou
réglage de durée d’événement

Esc Esc

Réglage durée ou volume d’un
événement

Cliquer + Déplacer poignée Cliquer + Déplacer poignée

Réglage fin durée ou volume d’un
événement

Ctrl + Cliquer + Déplacer poignée Ctrl + Cliquer + Déplacer poignée

Réglage de durée d’un événement
avec déplacement des données
adjacentes

Alt + Cliquer + Déplacer poignée Alt + Cliquer + Déplacer poignée

Extension d’un événement jusqu’au
début de l’événement suivant

Shift + Cliquer + Déplacer poignée Shift + Cliquer + Déplacer poignée

Sélection temporaire de l’outil de
sélection

F6 F6

Sélection temporaire de l’outil
Zoom

F7 F7

Options de l’outil Zoom Macintosh Windows
Sélection vue Cliquer + Déplacer Cliquer + Déplacer
Zoom avant 2X Cliquer Cliquer
Zoom arrière 2X Shift + Cliquer Shift + Cliquer
Sélection temporaire de l’outil de
sélection

F6 F6

Sélection temporaire de l’outil
Main

F7 F7

Navigation Macintosh Windows
Zoom avant/arrière Cmd + [ / ] Ctrl + [ / ]
Visualiser projet entier Cmd + Shift + Z Ctrl + Shift + Z
Visualiser échantillons Maintenez touche Z enfoncée Maintenez touche Z enfoncée
Défilement de la fenêtre d’édition
vers le haut/vers le bas

Page précédente / Page suivante Page précédente / Page suivante

Début/Fin de la fenêtre d’édition Début / Fin Début / Fin
Augmenter/diminuer la hauteur des
pistes

Cmd +     = / - Ctrl +     = / -

Visualiser le point In Shift + I Shift + I
Visualiser le point Out Shift + O Shift + O
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Annexe B : Assistance technique

Aide en ligne
Veuillez vous référer aux notes de mise à jour pour obtenir les dernières informations concernant l’aide en
ligne.

Mises à jour logicielles
Veuillez vous référer aux notes de mise à jour pour obtenir les informations concernant les mises à jour
logicielles.

Contacter le service clientèle
Veuillez vous référer aux notes de mise à jour pour obtenir les dernières informations relatives au service
clientèle.
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Annexe C : Description des erreurs et mises en garde

Liste de description des erreurs et des mises en garde. (N/C)

Annexe D : Icônes de la fenêtre Project/Track

Icône Description
Volume Macintosh

Volume Windows

Volume WaveFrame (MMR/MMP uniquement)

Volume de sauvegarde

Volume non identifié

Dossier



91

Index

A

Afficheurs de niveau,70
Annulation et rétablissement,38, 59
Automation des Mutes,72
Automation du volume par points d’édition,64,

71
Avance rapide et retour rapide,33

B

Barre Edit,16
Barre Machine Info,16

C

Chargement des projets,37, 73
Charger une piste,81
Clic dans la fenêtre principale de MX-View,35
Coller,46
Coller à gauche,47
Coller sur la position de la tête de lecture,48
Configuration de studio,83
Configuration requise,10
Connexion à plusieurs enregistreurs,82, 84
Connexion d’un MX-2424/MMR à un ordinateur

via un Hub Ethernet,10
Connexion directe d’un MX-2424/MMR à un

ordinateur,10
Conventions typographiques,8
Copier,46
Coupe à gauche,45
Coupe locale,44
Coupe locale à gauche,45
Couper,44
Création d’une nouvelle piste virtuelle,80
Créer un nouveau projet,17

D

Décharger une piste,81
Défilement à l’aide de la souris,37
Défilement vers le haut/bas dans la fenêtre

principale de MX-View,37
Définition des adresses IP,11
Diviser,52

E

Edition par glisser-déposer,59
Enregistrement automatique et répétition

automatique,38

Enregistrement élémentaire,37
Enregistrement en boucle,38
Evénements, régions et formes d’ondes,27
Extension jusqu’à l’événement suivant,63

F

Fades et Crossfades,20, 65
Fenêtre de transport,14
Fenêtre Groups (n/c),15
Fenêtre Location Markers (n/c),15
Fenêtre Meters,15
Fenêtre Network,17
Fenêtre Overview,15
Fenêtre Overviewn,35
Fenêtre principale de MX-View,13, 16, 17, 18,

20, 21
Fenêtre Project/track,14
Fenêtres arrimées,23
Fenêtres extensibles,25
Fonction Compile,69
Fonction de fusion des événements,58
Fonction In to now,57
Fonction Lock Trim,64
Fonction Repeat Selection,51
Fonction Sync Insert,55
Fonction Sync Paste,54
Fonctions Roll Back et Roll Forward,34
Forcer la sélection d’une région,38, 43, 55, 57,

58, 59, 60

G

Glissement des données d’un événement,68

H

Hauteur des pistes,36

I

Insérer,50
Introduction,8
Inversion des événements,59
Isoler,53

L

Lancement de la lecture à partir du point de
lancement précédent,31

Lecture,30, 33, 34, 35
Lecture avec Pre-Roll et Post-Roll,30, 32
Lecture de In à Out,30, 38, 39
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Lecture en boucle,31
Lecture et enregistrement élémentaires,18
Lecture inversée,33
Localisation des points In et Out,34
Localisation du début ou de la fin d’un projet,34

M

Menu des pistes,80
Mise à jour logicielle (MX-2424),78
Modes de lecture Audition,32
Modification de la durée d’un événement avec

déplacement des données adjacentes,63

N

Nudge,55

O

Option Locate with view,32
Options de visualisation,39
Ouvrir,49

P

Pages avec défilement de la tête de lecture,30,
35, 36, 37, 38

Placement de la tête de lecture sur l’édition
suivante/précédente,34

Placement de la tête de lecture sur le marqueur
suivant/précédent,34

Plusieurs enregistreurs en cours d’utilisation,84
Positions des fenêtres (n/c),25
Préférences (n/c),79
Presse-papiers multiples,46, 67
Principes d’utilisation de l’outil Drag and

Trim,60
Principes de base des pistes virtuelles,21
Principes de réglage des événements,20, 61, 68,

69

R

Ramenez la vue sur la tête de lecture,33

Réaliser une édition par copier-coller,18
Réglage de la durée de plusieurs événements,62
Réglage des événements audio,20
Réglage des points In et Out,28, 30, 31, 43
Réglage du volume des événements,64
Réglage horizontal,61
Réglages des menus (n/a),15
Renommer les événements,57
Renommer une piste,81
Retour de la tête de lecture sur sa position de

départ,33

S

Sauvegarde et restauration en réseau,75
Sélection d’une région à éditer,29, 41, 48, 49, 50,

51, 52, 53, 54, 55
Séparer,53
Supprimer,48
Supprimer une piste,81
Synchronisation externe,39

U

Utilisation des compteurs,28, 29, 33, 39
Utilisation des fenêtres,22, 23
Utilisation des groupes (n/c),70
Utilisation des marqueurs de localisation,34, 70
Utilisation des pistes,21, 26, 80
Utilisation des projets,25
Utilisation du compteur de la tête de lecture,33
Utilitaires de disque dur,77
Utilitaires des projets,73

V

Visualisation de la totalité d’un projet,36
Visualisation des échantillons,36

Z

Zoom horizontal,35
Zoom vertical,36
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